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Предисловие 

Учебно-методическое пособие предназначено для обучения студентов 

простейшим приемам решения типовых математических задач на персональном 

компьютере в программной среде системы компьютерной алгебры (СКА) 

Maple. За основу взята ее 18-я версия под управлением операционной системы 

Windows.  
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1. Первоначальное знакомство с Maple 18 

Maple − одна из лидирующих систем для выполнения символьных преоб-

разований математических выражений, численных расчётов и визуализации ре-

зультатов. Большое количество задач может быть решено в ней быстро и каче-

ственно в аналитическом виде. При отсутствии такой возможности Maple пред-

ложит численные методы, позволяющие получить ответ с очень большой сте-

пенью точности. Если необходим анализ данных, то найдется комплекс пакетов 

с арсеналом команд для их обработки и графической визуализации. К настоя-

щему времени программа, ежегодно обновляясь, превратилась в мощный вы-

числительный комплекс, предназначенный для выполнения сложных научно-

технических проектов и моделирования. Интуитивно ясный и понятный алго-

ритмический язык Maple позволяет программировать решение задач при отсут-

ствии в системе нужной встроенной команды и создавать пользовательские 

библиотеки. Наличие отличного редактора предоставляет возможность получе-

ния документа с высоким полиграфическим качеством. Графические встроен-

ные объекты позволяют создавать полезные интерактивные приложения. Не-

оценима помощь Maple и в обучении. Анимационные возможности и мощная 

графика способствуют более глубокому пониманию важных научных понятий, 

формул и законов. 

Функционально СКА состоит из ядра, выполняющего основные матема-

тические операции, библиотеки процедур-функций, специализированных паке-

тов и разных типов интерфейса. 

 

1.1. Структура окна стандартного интерфейса 

 

При запуске Maple 18 как Windows-приложения открывается окно со 

стандартным графическим интерфейсом программ, работающих под управле-

нием операционных систем этого семейства, и открытой стартовой страницей 

(файл start.mw). Общий вид окна представлен на рис. 1. 
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Рис. 1. Вид окна при первом открытии Maple 18 

Стартовая страница содержит кнопки, которые позволяют пользователю 

выбрать шаблон для создания нового файла (Document или Worksheet), изу-

чить справочные материалы (Help, Getting Started) по работе системы или 

найти образцы готовых примеров (Calculus, Mathematics и др.) для реализации 

своего проекта. 

Для запуска Maple-сессии (так называется сеанс работы в Maple) нужно 

произвести одно из следующих действий: 

1. На стартовой странице выбрать New Document (Новый Документ) 

или New Worksheet (Новый Рабочий Лист).  

2. Из меню File выбрать New, а затем или Document Mode, или 

Worksheet Mode. 

При открытии файла в режиме Document Maple выводит окно Quick Help 

(Быстрая Помощь) со списком некоторых важных «горячих» клавиш, которое 

автоматически сворачивается после начала работы. Для его последующего вы-

зова можно использовать управляющую клавишу <F1> из любого режима. Воз-
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вращение на стартовую страницу возможно с помощью нажатия кнопки  

панели инструментов. 

Таким образом, существует два основных режима работы стандартного ин-

терфейса: Document и Worksheet. Их подробное описание можно найти во встро-

енном в систему UserManual (Руководство пользователя) через установку действий 

из главного меню: Manuals, Resources, and more → Manuals → UserManual. 

Из каждого режима есть доступ к нужным для поставленных целей тех-

нологиям Maple. Главное же отличие связано с формой ввода и вывода инфор-

мации, установленной по умолчанию. Шаблон Document использует Document 

Blocks (Блоки Документа), которые при вводе частично скрывают синтаксис 

команд языка Maple. Например, при использовании контекстного меню, кото-

рое вызывается нажатием правой кнопки мыши при наведении ее указателя на 

объект области ввода, появляется лишь стрелка с именем нужной команды, свя-

зывающая ввод и вывод. Сам текст кода, использующийся для решения вы-

званной задачи, скрыт. Области блоков выделяются двумя треугольниками в 

вертикальном указателе слева от рабочего поля документа. По умолчанию они 

отключены, а сама область ввода выделяется пунктирными линиями в форме 

прямоугольника. Для того чтобы треугольники увидеть, нужно в главном меню 

открыть вкладку View и выбрать Markers. Режим Document включается также 

при создании нового файла путем нажатия кнопки  на панели инструментов. 

Режим Worksheet использует по умолчанию символ приглашения . 

Угол (>) красного цвета расположен справа от квадратной скобки, которая уве-

личивается по мере ввода символов. При вызове контекстного меню текст вы-

бранных команд в этом режиме автоматически прописывается на экране в об-

ласти ввода. 

Таким образом, главным основанием для выбора режима работы стан-

дартного интерфейса является необходимость видеть полный текст команд или 

скрывать некоторые их части. Следует учитывать, что скрывать текст команд в 

режиме Worksheet тоже можно, добавив блок документа из меню Format глав-
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ного меню: Format → Create Document Block, или, наоборот, можно показать 

команды в режиме Document, добавив приглашение командной строки из 

вкладки Insert в главном меню: Insert → Execution Group → Before/After Cursor. 

Эти переключения режимов можно осуществлять также с помощью кнопок  

и  панели инструментов. 

Изучим структуру окна стандартного интерфейса при создании нового 

файла. Так как существенно для разных режимов работы она не отличается, 

ограничимся режимом Worksheet. Это типичное окно ОС Windows, в котором 

можно выделить несколько основных частей (рис. 2). В верхней части под Заго-

ловком окна находится строка Главного меню, содержащая список возможных 

действий в системе Maple. Некоторые его части не доступны, пока на рабочем 

поле не появится соответствующий объект. 

 

Рис. 2. Общий вид стандартного интерфейса Maple 18 

Приведем краткое описание пунктов главного меню. 

File (Файл)  содержит стандартный набор команд для работы с файлами 

(сохранить файл, открыть файл, создать новый файл и т. д.). 

Edit (Редактирование)  содержит стандартный набор команд для редак-

тирования текста (копирование, удаление выделенного фрагмента в буфер об-

мена, отмена команды и т. д.). 

Заголовок окна 

Главное меню 

Панель  

инструментов 

Строка с именами 

открытых  

документов 

Рабочее поле 

документа Строка  

состояния 

Названия 

палитр  

инструментов Контекстная  

панель инструментов 
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View (Вид) – содержит стандартный набор команд, управляющих струк-

турой и содержимым видимой части окна интерфейса Maple (панели инстру-

ментов, секции, маркеры блоков документа и т. д.). 

Insert (Вставка) – содержит стандартный набор команд для вставки полей 

разных типов (для ввода команд в разных режимах, графических двух- и трех-

мерных изображений, рисования, ввода программного кода и т. д.). 

Format (Формат) – содержит стандартный набор команд для оформления 

документа (установка типа, размера и стиля шрифта). 

Tools (Инструменты) – содержит стандартный набор команд для вызова 

различных Maple-средств и установки (переустановки) параметров. 

Windows (Окна) – содержит стандартный набор команд для перехода из 

одного рабочего листа в другой, а также для управления их расположением на 

экране. 

Help (Справка) – содержит стандартный набор команд для вызова разных 

видов справочной информации о Maple и встроенных средствах, которые мож-

но использовать для решения задач и наглядного обучения. 

Ниже строки главного меню расположена Панель инструментов с кноп-

ками, дублирующими часто используемые его команды. 

Опишем назначение некоторых наиболее востребованных кнопок и соот-

ветствующие им команды: 

 − создать новый файл в режиме Document (File → New → DocumentMode); 

 − открыть существующий файл (File → Open…); 

 − сохранить текущий файл с уже заданным именем (File → Save); 

 − распечатать текущий файл (File → Print…); 

 − открыть предварительный просмотр текущего файла (File → PrintPreview…); 

 − вырезать выделенную часть файла в буфер обмена (Edit → Cut); 

 − скопировать выделенную часть файла в буфер обмена (Edit → Copy); 
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 − вставить информацию из буфера обмена в указанное курсором место те-

кущего файла (Edit → Paste); 

 − отменить последнее действие (Edit → Undo Insert Text); 

 − вернуться к последнему действию (Edit → Redo Insert Text); 

 − вставить область для ввода программного кода (Insert → Code Edit Region); 

 − вставить область для ввода текстового комментария (Insert → Text); 

 − вставить область для ввода командной строки в режиме 2D-Math с при-

глашающим символом после текущей группы вычислений (Insert → Execution 

Group → After Cursor); 

 − вставить область для ввода командной строки в режиме 2D-Math без при-

глашающего символа после текущей группы вычислений (Format → Create 

Document Block) или выделенную часть преобразовать в блок типа Document; 

 − открыть стартовую страницу (активировать кнопку start.mw в строке 

названий открытых файлов); 

 − выполнить все команды текущего документа (Edit → Execute → Work-

sheet); 

 − выполнить команды всех выделенных групп вычислений документа (Ed-

it → Execute → Selection); 

 − остановить выполнение текущей операции; 

 − очистить внутреннюю память Maple (команда restart); 

 − регулировать масштаб текста текущего документа (View → Zoom 

Factor → …); 

 − открыть справочную систему в новом окне (Help → Maple Help); 

 − строка для ввода поискового запроса справочной 

системе (Help → Maple Help). 
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Контекстная панель инструментов изменяется в зависимости от того, в 

какой области рабочего поля находится курсор и что в этой области отобража-

ется. Существует шесть видов контекстных панелей инструментов для следу-

ющих областей: ввода и вывода текущего документа в текстовом или матема-

тическом режимах; рисования; плоского, пространственного и анимационного 

графиков. Приведем их вид. 

Инструменты для форматирования текстовой строки 

 

 

Инструменты для правки рисунка 

 

Инструменты для работы с графикой на плоскости 

 

Инструменты для работы с графикой в пространстве 

 

Инструменты для работы с анимированной графикой 

 

Большую часть окна занимает Рабочее поле документа, содержащее ко-

манды, результаты их выполнения, текст, графику и другие объекты. Вся эта 

информация может быть отформатирована нужным образом, структурирована 

и оформлена как электронный документ с открывающимися или закрывающи-

мися элементами списка содержания. Во время работы для любого объекта до-

кумента, щелкнув правой кнопкой мыши в его зоне, можно отобразить Кон-

текстное меню, команды которого динамически генерируются в зависимости 
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от выбранной области. Для более детального ознакомления с этим инструмен-

том можно обратиться к справочной системе. 

Кроме непосредственного ввода команд с помощью клавиатуры, можно 

использовать Палитры, содержащие наборы шаблонов для ввода некоторых 

команд и объектов Maple. Более 20 их видов расположены в левой части экра-

на. Они могут быть в свернутом (рис. 3) или развернутом (рис. 4) виде. 

     

Рис. 3. Панель названий палитр   Рис. 4. Палитра для ввода выражений 

Интерфейс Maple является многодокументным, позволяющим открывать 

и работать одновременно с несколькими файлами, в том числе и справочными, 

при необходимости связывая рабочие документы посредством гиперссылок.  

По умолчанию в новом документе ввод команд Maple осуществляется в 

привычной математической записи формул 2D-Math (типографское изображе-

ние). Это отображается на контекстной панели подсветкой Math (рис. 5) и 

наклонным видом курсора в выделенной пунктиром прямоугольной области. 

 

Рис. 5. Вид окна и курсора в режиме математического ввода интерфейса Worksheet 
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Переключение режима ввода команды в текстовый формат (Maple Input) в 

разных режимах стандартного интерфейса немного отличается. Например, в 

Worksheet для этого можно использовать или управляющую клавишу <F5>, 

или выбор Text (см. рис. 5), при этом на контекстной панели появится запись 

Maple Input. Активация кнопки  на основной панели инструментов переве-

дет курсор на следующую строку после последней группы вычислений и пере-

ключит математический режим ввода команд в режим ввода текстовых ком-

ментариев, которые не обрабатываются интерпретатором Maple. При этом ис-

чезнет прямоугольник, в котором отражалась вводимая информация, а курсор 

примет вертикальное положение (рис. 6). 

 

Рис. 6. Вид окна и курсора в режиме ввода текстовых комментариев интерфейса Worksheet 

Текстовые комментарии можно вводить и в режиме командной строки, 

начиная их символом (#). Аналогичные переключения с незначительной разни-

цей можно производить и в режиме Document.  

Таким образом, режим Document позволяет создать качественный интер-

активный документ, в котором системные вычисления и их текстовое сопро-

вождение органично сочетаются, переплетаются между собой и могут быть от-

форматированы с высоким полиграфическим качеством. Команда и ее резуль-

тат могут быть выведены в одной строке при завершении ввода одновременным 

нажатием клавиш <ctrl>+<=>. Режим Worksheet требует записи команд по-

строчно в группах (группа может содержать и одну команду), а результат вы-

полнения выводится в следующей за группой строке. При этом приглашающий 

символ отображается при распечатке файла. В обоих режимах сохранилась 

возможность ввода команды в виде, присущем ранним версиям Maple (Maple 

Input, или 1D-Math). В этом случае отображение символов на экране идет крас-
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ным цветом (если не изменены системные настройки), и завершение каждой 

команды знаком (;) или (:) строго обязательно. Оператор (;) означает, что ре-

зультат выполнения соответствующей команды появится в области вывода по-

сле ее обработки. Фиксатор (:) используется для подавления вывода на экран, 

то есть переводит команду в ее инертное выполнение. Таким образом, основ-

ные режимы работы можно выделить кратко в сводной схеме, представленной 

на рис. 7.  

Рис. 7. Краткая схема переключения режимов работы 

Следует отметить еще одну возможность для создания качественного 

электронного документа. Из вкладки Insert главного меню можно выбрать спе-

циальный объект Section (Секция) (или использовать две специальные кнопки 

основной панели инструментов), который представляет собой серый треуголь-

ник с вертикальной скобкой, ограничивающий группу вычислений и текстовых 

строк. При нажатии на треугольник информация сворачивается, а сам он при-

Стандартный интерфейс Maple 18 

Document Mode Worksheet Mode 

Ввод командной строки в 

режиме 2D-Math 

без символа приглашения 

Текстовые 

комментарии 

Ввод командной строки  

в режиме 2D-Math с 

символом приглашения 

Ввод командной 

строки в режиме 

1D-Math 

<F5> 
<F5> 

Ввод текстовых 

комментариев 
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обретает направление вправо, подчеркивая тем самым наличие содержания. 

Повторное нажатие приводит к разворачиванию содержимого. Более подробно 

изучить возможности форматирования можно, воспользовавшись справочной 

системой. 

Заметим, что в дальнейшем мы будем использовать системные настройки, 

но их можно изменить, выбрав из заголовка Tools главного меню вкладку 

настроек Options. 

 

1.2. Первая Maple-сессия 

 

Сеанс работы в Maple обычно называют сессией. Пользователь вводит 

предложения (выражения, команды, процедуры, текст и т. п.), которые обраба-

тывает система Maple. Рабочее поле при этом разделяется на две части: 

1) область ввода, состоящая из командных строк и текстовых комментариев; 

2) область вывода, содержащая результаты обработки введенных команд в 

виде аналитических выражений, графических объектов или сообщений об ошибках. 

Область текстовых комментариев не воспринимается и не обрабатывается 

Maple. 

Область ввода и соответствующая ей область вывода называются группой  

вычислений. На рабочем листе она отмечается квадратной скобкой слева. В 

группе вычислений может содержаться несколько команд и операторов: все они 

обрабатываются системой за одно обращение при нажатии клавиши <enter>. 

Одна команда, введенная в математическом режиме, может подаваться 

сразу на выполнение клавишей <enter>. При этом, если она завершается фикса-

тором (;) конца записи, то результат выводится на экран. Если фиксатор отсут-

ствует, то интерпретатор автоматически добавляет его. Для подавления вывода 

на экран результата работы команды ее следует завершить двоеточием (:). При 

последовательной записи команд одной группы вычислений перевод на следу-

ющую строку осуществляется клавишами <shift>+<enter>. При этом, если ко-
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манды отделены друг от друга точкой с запятой, вывод будет осуществлен в 

порядке их следования со строки, следующей за последней командой группы. 

Если же фиксатор (;) пропущен, то вывод может быть неожиданным или соот-

ветствовать последней выведенной команде. Так как Maple имеет общую внут-

реннюю память, для корректности работы новую задачу на одном рабочем ли-

сте рекомендуется начинать командой restart, которая обнуляет все регистры и 

отключает все подключенные библиотеки. Аналогичное действие совершается 

при помощи соответствующей кнопки  панели инструментов. 

При работе в текстовом режиме клавиша <enter> переводит запись на 

следующую строку, никакой результат при этом не выводится. 

Большое количество математических расчетов в Maple 18 можно прово-

дить без непосредственного прописывания инструкций (например, используя 

контекстное меню или специализированные браузеры), но все его возможности 

и преимущества сосредоточены в командах и средствах программирования. 

В командную строку (напоминаем, что она начинается знаком приглаше-

ния (>) для ввода команды в режимеWorksheet, а в режиме Document этот 

символ скрыт) можно записать любое алгебраическое выражение. После нажа-

тия клавиши <enter> или кнопки с одним восклицательным знаком на инстру-

ментальной панели она будет обработана системой, а результат выведен на 

экран (если завершить двоеточием, вывод на экран будет подавлен): 

   [ ] (  )     (    ) 

     ( ) 

Если команда содержит синтаксические ошибки или ошибки выполнения, 

то система в области вывода напечатает сообщение об их характере. Для ис-

правления ошибки следует вернуться к оператору, исправить его и снова подать 

на выполнение. В любой момент работы так можно обратиться к уже введен-

ным командам, требующим корректировки. 

Библиотека Maple 18 состоит из двух частей: главной библиотеки, содер-

жащей наиболее востребованные функции и команды, и библиотеки специали-
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зированных пакетов, содержащей команды для решения задач из определенных 

разделов математики. Список всех функций и команд главной библиотеки 

можно получить по установке Help → Manuals, Resources, and more → List of 

Commands, а пакетов − Help → Manuals, Resources, and more → List of Packages. 

Ввод стандартной команды Maple в режиме 2D-Math отображается чер-

ным шрифтом и имеет вид Имя_команды(аргументы, параметры), где 

Имя_команды – ключевое слово команды, аргументы, параметры – обязатель-

ные и дополнительные параметры соответственно. При наборе в режиме Maple 

Input (установка Insert → Maple Input) символы меняют цвет на красный, за-

пись идет в одну линию, и каждая команда обязательно должна завершаться 

знаком (;) или (:). 

Выполните приведенные ниже примеры решения нескольких задач в ре-

жиме 2D-Math интерфейса Document. Для этого: 

1) откройте новый документ со стартовой страницы или из главного ме-

ню, режим 2D-Math будет задан по умолчанию; 

2) текстовую информацию вводите в режиме Text, а команды − в режиме 

Math (переключение режимов осуществляйте клавишей <F5> или выбором в 

строке контекстного меню слов Text или Math соответственно); 

3) завершайте ввод каждой команды нажатием клавиши<enter>.  

Если все будет введено без ошибок, то в центре следующей за командой 

строки синим цветом будет выведен результат. 

Примеры 

Разложить квадратный трехчлен на множители: 
      (       ) 

(   )  

Продифференцировать заданную функцию: 

 

 

Вычислить определенный интеграл: 
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Найти приближенное значение (в записи использовать пять значащих 

цифр) выполненной на предыдущем шаге операции: 

 
       

Построить график функции на заданном промежутке:  

 

 
Для вызова команды из пакета существует два варианта: загрузить весь па-

кет с помощью команды with(Имя_пакета) и далее использовать обычный формат 

записи команды или вызвать команду без подключения всего пакета с помощью 

длинной формы ее записи Имя_пакета[Имя_команды](аргументы,параметры).  

Удобно для первоначального ознакомления с командами пакета не за-

вершать команду его подключения двоеточием. В этом случае их полный спи-

сок выведется на экран. Далее можно, выделив нужную команду, скопировать 

ее в указанное курсором место рабочего листа или получить доступ к полной 

справке о ней с помощью нажатия управляющей клавиши <F2>. 

 

1.3. Навигация по справочной системе и полезным утилитам 

 

Остановимся подробнее на получении справочной информации в Maple, 

доступ к которой обеспечивает вкладка Help (Справка) главного меню. В осно-

ву справочной системы положено понятие гипертекста, состоящего из около 

5000 связанных страниц, что позволяет быстро найти полную информацию по 

необходимому вопросу. 
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Для доступа к справочной системе можно использовать одно из следую-

щих действий: 

1) из главного меню выбрать вкладку Help → Maple Help; 

2) нажать комбинацию клавиш <ctrl>+<F1>; 

3) ввести в окошке основной панели инструментов слово для поиска; 

4) нажать кнопку  основной панели инструментов; 

5) выделить на рабочем листе слово, по которому нужна справка, и нажать 

<F2>. 

В любом из перечисленных вариантов откроется окно справочной систе-

мы, разделенное на две вертикальных части: левая часть состоит из окошка для 

ввода поискового запроса и раскрывающегося краткого содержания справочной 

системы, справа – вывод информации по введенному запросу или выбранному 

пункту интерактивного содержания. 

Около названий пунктов содержания на левой панели можно заметить 

значки. Приведем их значение: 

 − означает наличие подпунктов соответствующего пункта; 

 − указывает на страницу справки, которая появится на правой панели; 

 − означает, что откроется страница с примерами; 

 − откроется страница с определением соответствующих понятий; 

 − примеры соответствующих задач; 

 − указывает на соответствующий учебник. 

Примеры, приведенные в справочной системе, можно выполнить, открыв 

вкладку View → Open Page as Worksheet или скопировав нужную их часть в 

свой рабочий лист. Для переключения режима ввода в 2D-Math можно нажать 

кнопку . Заметим, что некоторые команды требуют ввода только в 1D-Math. 

В этом случае результат не изменится. Для более полного ознакомления со 

структурой справочной системы и работой с ней можно сделать запрос со сло-

вом help navigator. 
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В справочной системе, кроме информации по работе с самой системой, 

можно найти математические и инженерные словари, содержащие более 5000 

понятий и около 300 рисунков и графиков. Выход в Интернет дает возможность 

связаться с имеющимися в сети источниками нужной информации, в частности, 

связаться с главным сайтом производителя http://www.maplesoft.com. 

 

Упражнения 

 

1. Откройте установленную на вашем компьютере СКА Maple 18. Со-

здайте новый файл в режиме Document. Изучите открывшееся окно Quick Help 

c набором горячих клавиш. Потренируйтесь вызывать справочную систему 

разными способами на основании материала подразд. 1.3. Найдите различные 

учебники с использованием содержимого вкладки Help главного меню. 

2. Создайте новый файл в режиме Worksheet. Используя материал под-

разд. 1.1, изучите команды основного меню и возможности палитр.  

3. Выполните в обоих файлах задачи подразд. 1.2 и сохраните их. 

4. Вернитесь на загрузочную страницу и ознакомьтесь с материалом, ко-

торый выводится при нажатии кнопок Mathematics и Discrete Mathematics.  
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2. Работа с основными математическими объектами 

2.1. Числа и действия над ними 

 

Рассмотрим работу с действительными (real) числами. Их можно вводить 

и получать в разных форматах. Для целых чисел – тип integer – это обычный 

ввод цепочки цифр, начинающейся минусом для отрицательных чисел, деся-

тичной системы счисления: 2, 42, 0, −372. Рациональные числа могут быть за-

даны несколькими способами. Прежде всего, это запись в виде отношения двух 

целых чисел: 2/5, 79/8, −142/2. Maple при выводе сразу упрощает результат до 

несократимой дроби или целого числа. При записи числа в виде конечной деся-

тичной дроби – тип float – в качестве разделителя целой и дробной частей ис-

пользуется точка: 24.42, 0.64 или просто .64. Число выведется в показательной 

форме, если его записать как произведение десятичной дроби на степень с 

натуральным показателем по основанию 10, причем мантисса приведется к 

стандартному виду (число из диапазона от 1 до 10) формата float c округлением 

до значения, определяемого текущим значением системной переменной Digits. 

По умолчанию ее значение равно 10. Наконец, точные иррациональные числа, в 

том числе радикалы 1/nm  или n m , алгебраические числа (корни алгебраиче-

ских уравнений с целыми коэффициентами) и трансцендентные числа, не яв-

ляющиеся алгебраическими (, е и др.) представляются своей символьной запи-

сью. 

Система Maple поддерживает точное представление чисел, хотя при деся-

тичной нотации чисел имеется практически неограниченное число разрядов. 

Выяснить его значение можно с помощью команды kernelopts (maxdigits). В по-

следних версиях системы оно достигает сотен миллионов, точнее,  268 435 448. 

Maple стремится оперировать именно с точными (символьными) представлени-

ями. Вынудить ее перейти к приближенным значениям можно только специ-

ально, в частности, применяя функцию evalf. Таким образом, и при десятичной 

записи можно обеспечить большую точность вычислений, присваивая систем-

Би
бл
ио
те
ка

 БГ
УИ
Р



 

23 

 

ной переменной Digits требуемое число разрядов в десятичном представлении 

чисел. Но следует помнить, что переход к приближенным значениям лучше вы-

полнять уже для конечного результата. 

Проиллюстрируем сказанное с помощью задачи по извлечению корня 

третей степени целого числа (без десятичной точки) с использованием двух 

операций: приближенного вычисления и упрощения, так как непосредственный 

ввод выражения не приводит к нужному результату (все примеры в дальней-

шем будем выполнять в интерфейсе Worksheet):  

>  

 

>  

 

>  

 

Дадим пояснения. Унарный оператор % обращается к результату преды-

дущей команды (возможны еще %% и %%%). Команда evalf может иметь сле-

дующий формат ввода: evalf(expr), evalf(expr, n) или evalfn(exrp), где expr −  вы-

ражение, для которого нужно найти приближенное значение; n − количество 

значащих цифр в записи результата (необязательный параметр, по умолчанию 

равный 10). Для записи символов в нижнем регистре можно использовать соче-

тание клавиш <shift>+<ctrl>+<->. Команда simplify проводит алгебраические 

преобразования с целью максимального упрощения и получения точного ре-

зультата. Если применить плавающую арифметику, то результат будет не-

сколько отличаться:  

>  

 

>  

 

>  

 

 

Количество значащих цифр по умолчанию 10. Действие команды evalf 

распространяется только на текущую операцию. 
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Найдем с помощью Maple значение арифметического выражения. Ввод 

осуществляется естественным способом с учетом круглых скобок и приоритета 

операций. Знаки самих арифметических операций вводятся согласно табл. 1 и 

при наборе в режиме 2D-Math автоматически преобразуются в привычную 

формульную запись. При вводе в формате Maple Input (текстовый набор ко-

мандной строки) вводимые символы не преобразуются. 

Таблица 1 

Арифметические операции 

 

Замечание 1. Для ввода команд можно использовать шаблоны из палитры 

Expressions для ввода выражений (см. рис. 4). Для этого нужно щелкнуть по 

нужному шаблону, чтобы он появился в области ввода, а затем ввести в выде-

ленные места значения переменных. 

Замечание 2. При наборе необходимо использовать клавишу навигации → 

для выхода из зоны набора, например, знаменателя или показателя степени. 

Замечание 3. Запись отношения двух целых чисел в виде обыкновенной 

дроби преобразуется автоматически в несократимую дробь.  

Вычислим значение выражения  

(7 6,35) :6,5 9,9
.

5 169
1,2 :36 1,2 :0,25 1 :

16 24

 

 
  

 

 

Введем следующий набор символов: 

((7−6.35)/6.5→+9.9)/(1.2/36→+1.2/0.25→−1−5/16→)/169/24→→→<enter>. 

Операция Клавиша знака операции Ввод Вид 

Сложение + 24+42 24 42  

Вычитание − 24−42 24 42  

Умножение * 24*42 24 42  

Деление / 24/42 
24

42
 

Возведение в степень ^ 24^42 4224  
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Результат: 

>  

 

Смешанное число вводится как сумма целой и дробной части или как не-

правильная дробь. Естественно, это же задание можно выполнить, разбив на 

необходимое число шагов по два операнда. 

При вводе математических констант (табл. 2) можно использовать или их 

непосредственный набор по правилам Maple, или применять палитры.  

Таблица 2 

Математические константы 

Константа Набор клавиш 

π Pi 

i (мнимая единица) I 

  Infinity 

e (основание натуральных логарифмов) exp(1) 

γ (константа Эйлера) Gamma 

логические 1 и 0 true, false 

 

Заметим, что при наборе с клавиатуры буквы e она будет восприниматься 

как обычная переменная. Поэтому используется ввод с помощью встроенной 

функции exp(x) или с помощью шаблона из палитры Expression. Для того что-

бы значения трансцендентных функций от целых аргументов выводились в 

числовом формате (т. е. в виде приближенного числа), можно при их вводе ис-

пользовать десятичную точку. 

Сравните: 

>  

 

>  
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>  

 

>  

 

>  

 

Для записи греческих букв в полиграфическом виде можно использовать 

специальную палитру Greek или команду, соответствующую нужной букве 

(табл. 3). При наведении указателя мыши на нужную букву в палитре всплыва-

ет подсказка с ее командой. Для ввода заглавной греческой буквы следует 

начинать ввод с прописной буквы (alpha – Alpha). В области ввода отобразится 

команда, а в области вывода − соответствующая буква: 

>  

 

>  

 

Исключение составляют математические константы   и  , для которых 

используются команды Pi и gamma соответственно: 

>  

 

>  

 

 

Но! 

>  

 

>  

 

>  

 

>  
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Таблица 3 

Греческие буквы (строчные) 

  alpha η eta μ mu σ sigma 

  beta θ theta ν nu φ varphi 

δ delta ι iota ξ xi χ chi 

ε epsilon κ kappa π pi ψ psi 

ζ zeta λ lambda ρ rho ω omega 

 

Основные элементарные математические функции входят в стандартную 

библиотеку Maple и вводятся в привычном формате function(argument). Их пе-

речень приведен в табл. 4. Слева приводится математическая запись, справа – 

запись в Maple.  

Таблица 4 

Встроенные математические функции 

x  sqrt(x) loga x  log[a](x) sec x sec(x) arcctg x arcccot(x) 

|x| abs(x) sin x sin(x) cosec x csc(x) sh x sinh(x) 

xe  
exp(x) cos x cos(x) arcsin x arcsin(x) ch x cosh(x) 

ln x  ln(x) tg x tan(x) arcos x arcos(x) th x tanh(x) 

lg x log10(x) ctg x cot(x) arctg x arctan(x) cth x coth(x) 

 

Упростим выражение 4 2 3 4 2 3   с помощью разных способов вы-

полнения и вывода результата. 

Ввод с клавиатуры в синтаксисе Maple: 

>  

 

>  

 

> 
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Иногда не удается преобразовать числовое выражение, содержащее 

трансцендентные функции целого аргумента, к нужной форме. В этом случае 

можно попробовать решить задачу с переменными величинами, а затем подста-

вить вместо них нужные числа: 

>  

 

>  

 

>  

 

>  

 

 

 

Команда factor (разложить на множители) не привела к получению чис-

лового выражения в виде произведения, но после замены чисел на переменные 

и подстановки нужных значений результат получен. Более подробно о коман-

дах преобразований выражений будет сказано дальше. 

Приведем примеры нахождения точных и приближенных значений неко-

торых математических функций: 

>  

 

>  

 

>  
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>  

 

>  

 

>  

 

>  

 

>  

 

Для тригонометрических функций часто бывает необходимо представление 

аргумента в разных формах: радианной или градусной. Для перевода из одной ме-

ры в другую можно использовать универсальную команду преобразования 

convert. Для перевода в градусную меру требуется формат записи команды 

convert(number, degrees), где number – радианное значение, а для обратной задачи − 

convert(number degrees, radians), где number – градусное значение. Например: 

>  

 

>  

 

Комплексное (complex) число z записывается в алгебраической форме как 

 ̅      . В командной строке такая запись должна вводиться так:  ̅       . 

Мнимая единица обозначается как I. Функции Re(z) и Im(z) возвращают дей-

ствительную и мнимую части комплексного числа, а функция abs(z) − вычисля-

ет его модуль. Комплексно-сопряженное число  ̅       можно найти с по-

мощью команды conjugate(z).  

Если комплексное выражение очень сложное или содержит параметры, то 

команды Re(z) и Im(z) могут не выдать требуемого результата. Получить веще-

ственную и мнимую части комплексного выражения z в этом случае можно по-
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пробовать с помощью команды преобразования комплексных выражений 

evalc(z), которая возвращает упрощенное выражение в алгебраическую форму. 

Модуль и аргумент (главное значение в диапазоне (–π, π]) комплексного 

выражения z можно найти сразу с помощью команды polar(z) или по отдельности: 

|z|, или abs(z), – для нахождения модуля, argument(z) – для нахождения аргумента. 

Найдем значение z комплексного выражения 
101 2

2 3

i
i

i




  
в алгебраической 

форме. Для этого в командной строке наберем  

z:=(1+2*I)/2-3*I<→>+I^10<enter>.  

В результате должно получиться 

>  

 

Для выделения действительной и мнимой частей, нахождения сопряжен-

ного ему значения z  и проверки, что 2Re( ), 2 Im( )z z z z z i z    , введем 

нужные команды: 

>  

 

 

>  

 

>  

 

 

Для нахождения модуля и аргумента числа 3z i  , а также значения 

20z  введем следующее: 

>  

>  
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>  

 

>  

 

>  

 

Рассмотрим более сложную задачу нахождения модуля и аргумента ком-

плексного числа        
 

 
     

 

 
, в которой требуется процедура упрощения 

результата: 

>  

 

>  

 

>  

 

Найти все значения 6 1  и изобразить соответствующие им точки на ком-

плексной плоскости можно с помощью следующих действий: 

>  

>  

 

>  

 

>  
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>  

 
Для нахождения всех значений корня была задана известная из ком-

плексного анализа формула как функция, зависящая от номера k корня по от-

ношению к его главному значению (при k = 0). Затем с помощью простого цик-

ла было найдено семь значений корня для того, чтобы показать, что седьмое 

значение совпадет с главным (и цикл далее продолжится), и чтобы построить 

замкнутый правильный шестиугольник, вершины которого соответствуют 

найденным шести различным значениям 6 1 . 

Приведем примеры нахождения значений функций комплексного пере-

менного, используя логарифм. Задачи с другими комплексными функциями 

можно решать по аналогии. 

Для нахождения главного значения логарифма числа ( 1 i  ) можно 

набрать соответствующую этой математической функции команду ln и приме-

нить к результату evalc-процедуру: 

>  
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Можно получить запись результата также в виде равенства: 

 

>  

 

 

 

Для нахождения всех значений натурального логарифма комплексного 

числа можно определить соответствующий функциональный оператор (см. бо-

лее подробную информацию о способах задания функций в разд. 4). Например 

следующим образом: 

>  

 

Тогда для нахождения частных значений может быть использована при-

вычная математическая запись: 

>  

 

>  

 

 

2.2. Тождественные преобразования выражений 

 

Maple обладает широкими возможностями для проведения аналитических 

преобразований математических выражений. К ним относятся такие операции, 

как приведение подобных слагаемых, разложение на множители, раскрытие 

скобок, приведение рациональной дроби к нормальному виду и многие другие. 

Выделение частей выражений 

Математическая формула, над которой будут производиться преобразо-

вания, записывается в форме >eq:=expr1=expr2 (eq – назначенное имя (иденти-
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фикатор) выражения; expr1 – условное обозначение левой части формулы; 

expr2 – условное обозначение правой части формулы) . 

Выделение правой части выражения осуществляется командой rhs(eq), 

выделение левой части выражения – командой lhs(eq): 

>  

 

>  

 

>  

 
 

Если задана рациональная дробь вида m/n, то можно выделить ее числи-

тель и знаменатель с помощью команд numer(m/n) и denom(m/n) соответственно: 

>  

 

>  

 

>  

 

 
 

Тождественные преобразования математических выражений 

1. Раскрытие скобок осуществляется командой expand(expr): 

 

>  

 

>  

 

 

Команда expand может иметь дополнительные параметры, позволяющие 

при раскрытии скобок оставлять определенные выражения без изменения, а 

также поддерживает большое  количество специальных  математических  функ-  

Би
бл
ио
те
ка

 БГ
УИ
Р



 

35 

 

ций (см. Help-поддержку). Например, пусть требуется каждое слагаемое выра-

жения cos sin 1x x   умножить на выражение x + y. Тогда в командной строке 

следует ввести 

>  

 

2. Разложение многочлена на множители осуществляется командой 

factor(expr): 

>  

 

Разложение на множители тригонометрических выражений с помощью 

этой команды не всегда возможно. Сравните: 

>  

 

>  

 

Но применение команды expand  поможет решить проблему: 

>  

 

>  

 

3. Дробь можно привести к стандартному виду с помощью команды 

normal(expr). Сравните: 

>  

 

>  

 

>  

 

4. Универсальная команда упрощения выражений − simplify(expr). В каче-

стве дополнительных параметров можно указать, виды каких выражений нужно 

преобразовывать. Стандартные параметры: trig – преобразование тригономет-
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рических выражений; power –  степенных; radical, или sqrt, – иррациональных; 

exp – показательных; ln – логарифмических. Использование параметров намно-

го увеличивает эффективность этой команды. Для ограничения области вычис-

лений можно использовать специальный пакет RealDomain, в котором исполь-

зуются только действительные числа, или команды assume и assuming (более 

подробно изучить их назначение позволит справочная система Maple). Сравните: 

>  

 

>  

 

>  

 

Замечание. csgn(x) – пороговая функция, принимающая значение 1 при 

положительных значениях аргумента, (−1) – при отрицательных, 0 – в нуле. 

5. Приведение подобных членов в выражении осуществляется командой 

collect(expr,var), где expr – выражение, var – имя переменной, относительно ко-

торой следует приводить подобные. 

6. Для упрощения выражений, содержащих не только квадратные корни, 

но и корни других степеней, лучше использовать команду radnormal(eqpr). 

Сравните: 

>  

 

>  

 

7. С помощью универсальной команды convert(expr, param), где expr – 

выражение, которое будет переведено в указанный тип param, осуществляет-

ся большое количество разнообразных преобразований. В частности, можно 

привести тригонометрическое выражение, содержащее   n x и     x, в выраже-

ние, 
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содержащее только tg x, если указать в качестве параметра tan, или, наоборот, 

содержащее tg x, ctg x можно перевести в   n x и с   x, если в параметрах ука-

зать   n   . 

Вообще, команда convert имеет более широкое назначение. Она осу-

ществляет преобразование выражения одного типа в другой. Например: 

convert(list, Vector) – преобразование некоторого списка l  t в вектор с теми же 

элементами; convert(expr, string) – преобразование математического выражения 

в его текстовую запись. Для вызова подробной информации о назначении па-

раметров команды convert, а также по любой другой команде,можно выделить 

набранное имя этой команды и нажать клавишу <F2>.  

8. Для проверки истинности тождества можно применить команду testeq. 

 

2.3. Решение уравнений и их систем 

 

Решение алгебраических уравнений 

Для решения уравнений в Maple существует универсальная команда 

solve(eq,x), где eq – уравнение, x – переменная, относительно которой надо ре-

шить уравнение. В результате выполнения этой команды в строке вывода по-

явится выражение, которое является решением данного уравнения 

Если уравнение имеет несколько решений, которые понадобятся для 

дальнейших расчетов, то команде solve следует присвоить имя name. Обраще-

ние к k-му решению данного уравнения производится указанием его имени с 

номером решения k в квадратных скобках: name[k]: 

>  

 

>  

 

 

Функция solve проводит решение в аналитическом виде, которое обычно 

имеет символьный вид. Для получения числовых значений корней (точнее их 
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приближенных значений) можно использовать функцию evalf или записывать 

числовые коэффициенты уравнения в формате с плавающей точкой: 

>  

 

>  

 

>  

 

Решение тригонометрических уравнений 

Команда solve, примененная к тригонометрическому уравнению, выдает 

только главные решения, то есть в интервале (–π, π]. Для того чтобы получить 

все решения, следует осуществить назначение системной переменной командой 

_EnvAllSolutions:=true. Сравните: 

>  

 

>  

>  

 

Символ _Z1~ обозначает константу целого типа, поэтому общее решение 

данного уравнения имеет вид    
 

 
    , где kZ . 

Решение систем уравнений 

Систему уравнений в Maple можно решить также с помощью команды 

solve, но в формате solve({eq1,eq2,…},{x1,x2,…}). Аргументы команды − урав-

нения, указанные в первой паре фигурных скобок через запятую, и переменные, 

относительно которых требуется решить систему, − во второй. Если необходи-

мо для дальнейших вычислений использовать полученные решения уравнений, 

то команде solve следует присвоить имя name с помощью оператора присваива-

ния или команды assign(name). После этого над решениями можно производить 

математические операции: 

>  
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>  

 

Если Maple не может получить корни уравнения или системы уравнений 

в радикалах, в ответе появляется функция RootOf. Для получения ответа в яв-

ном виде можно использовать команду allvalues(expr): 

>  

 

 

>  

 

Для численного решения уравнений в тех случаях, когда уравнения не 

имеют аналитических решений (или когда система не смогла найти решение в 

виде действительного числа), используется специальная команда fsolve(eq,x), 

параметры которой такие же, как у команды solve. Сравните разные решения: 

>  

 

>  

 

>  

 

>  
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Решение рекуррентных и функциональных уравнений 

Команда rsolve(eq,f) позволяет решить рекуррентное соотношение для 

функции f(n) натурального аргумента. Если задать для нее начальное условие, 

то может быть получено и частное решение. Например: 

>  

 

 

 

 

Универсальная команда solve позволяет решать также и функциональные 

уравнения, например: 

>  

 

В результате получилось решение в неявном виде. Однако Maple может 

работать с такими решениями. Неявное решение функционального уравнения 

можно попытаться преобразовать в какую-либо элементарную функцию с по-

мощью команды convert. Продолжая приведенный выше пример, можно полу-

чить решение в явном виде: 

>  
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Решение трансцендентных уравнений 

При решении трансцендентных уравнений для получения решения в явном 

виде перед командой solve можно ввести дополнительную команду 

_EnvExplicit:=true, которая присваивает системной переменной логическое значение 

истина. Это является указанием к нахождению решений в явном виде. Приведенный 

ниже пример иллюстрирует получение всех решений системы в нужном виде и 

дальнейшее их приведение к приближенным значениям. Можно убедиться, что 

множество решений содержит одно действительное и пять комплексных решений: 

>  
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>  

 

 

 

 

 

Решение уравнений в целочисленном виде 

Если нужен результат в целых числах, то можно использовать функцию 

isolve( ( ),f x x ): 

>  

 

Подставляя вместо системной переменной _Z1 любые целые значения, 

можем получать частные решения: 

>  

 

 

 

 

 

 

 

2.4. Решение неравенств, их систем и совокупностей 

 

Решение неравенств 

Команда solve применяется как для решения уравнений, так и для реше-

ния неравенств. Решение неравенства выдается в виде интервала, в котором мо-

гут изменяться искомые значения переменной. В случае, когда решением нера-

венства является полуось, в поле вывода можно увидеть конструкцию вида 

RealRange(–, Open(a)), которая означает, что x(–, a). Ключевое слово Open 

означает, что луч открытый. Если этого слова нет, то начало луча включено во 

множество решений. Например: 
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>  

 

Если нужно получить решение неравенства не в виде интервального 

множества, а в виде ограничений для искомой переменной, то переменную, от-

носительно которой следует разрешить неравенство, следует указывать в фи-

гурных скобках. Например: 

>  

 

 

Решение систем неравенств 

Систему неравенств можно также решить с помощью команды solve, из-

менив немного формат ввода ее аргументов: 

>  

 

Для геометрической интерпретации решения системы неравенств можно 

использовать, например, следующую функцию (более подробно о графических 

средствах Maple будет сказано далее): 

>  
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Упражнения 

 

1. Найдите точные и приближенные значения выражений: 

1) 
20 0.097

0.2 ;
99 1 0.01

 


   

2)  
12 3 15

3 5 ;
3 1 3 2 3 3

 
    

   
 

3) 34 3 44 3
1

32 4 64 3 2 2;
2

       

4) 2(4 3 2) 8 34 24 2 5;     

5) 43 30 2 43 30 2;    

6)                   
 

 
       ; 

7)     
  

 
   

  

 
   

 

 
   

8) 
5

arctg3 arcsin ;
5

  

9) 
1 1 1

2 2 2

1
log 27 log 24 2log 3.

3
   

2. Вычислите: 1) 
5( 1 ) ;i   2) 

π/2.ie  

3. Найдите: 

1) модуль и аргумент комплексных чисел: 2 2 ; 1 3 ; 2 5 ; 2i i i i      ; 

2) квадрат и куб чисел:    ;    ; 

3) значение выражения 
(      )(      )

    
 ,        ,         ; 

4) синус, косинус, логарифм, арктангенс, корень комплексного числа 2 3i . 

4. Упростите: 

1) 
4 2

3 2

3 4

1

x x

x x x

 

  
;  2) 

2 2 2

( )( ) ( )( ) ( )( )

x yz y xz z xy

x y x z y x y z z x z y

  
 

     
; 
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3) 
2

cos(5π 2 )

7π
2sin ( )

2





x

x

; 4) 
tg5 ctg7

ctg5 tg7





x x

x x
. 

5. Разложите на множители: 

1) 6 1x  ; 2) 3 23 5 15x x x   ; 3) 2 27 12x xy y  ; 4) 4 3 3 4 2 54 16 16x y x y x y  . 

6. Решите уравнения: 

1) 
 

2

3 2 4

3 52

x

xx





; 2) 5sin 12cos 13x x  ; 3) ln 1x x  ; 4) 2 5 0x x   . 

7. Решите системы уравнений: 

1) 
2 2

2

1;

2;

x y

x xy

  


 

 2) 
16 16 68;

16 256;

x y

x y

  




 3) 

2 2

1
cos cos ;

2

7
sin cos ;

4

x y

x y


 


  


 4) 
2 2

2

4 2

log ( ) 7;

2log log 6.

x y

x y

  


 

 

8. Решите неравенства: 1) 4 23 6 2 0x x x    ; 2) 2 3 1xe   . 
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3. Графика и анимация 

3.1. Геометрические построения на плоскости 

 

График явно заданной кривой 

Самый простой способ для построения графика действительной функции 

y = y(x), зависящей от одной переменной, − использование команды plot(y(x), 

options), где options − параметры (необязательные) управления характеристика-

ми изображения: 

>  

 
Редактирование полученного чертежа можно осуществить с помощью 

контекстного меню, которое открывается щелчком правой кнопки мыши после 

наведения ее указателя на область графики. По умолчанию диапазон изменения 

независимой переменной (−10…10), а для тригонометрических функций –  

(–2π…2π). Для установки параметров управления изображением необходимо 

записать команду в более полном формате: ( ( ), )plot y x options , где options –  

параметры настройки. Если их не указывать, то будут использованы установки 

по умолчанию. 

Перечислим значения некоторых дополнительных опций команды plot: 
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1) axes = t – установка формы координатных осей (значения t могут быть 

normal – оси как две пересекающиеся прямые, boxed – график в рамке со шка-

лой, frame – оси с центром в левом нижнем углу рисунка, none – без осей); 

2) axis[dir] = t – установка параметров цвета, градации других 

характеристик одной или обеих осей (если dir = 1 – установки касаются оси Ox, 

dir = 2 – оси Oy, параметр dir отсутствует – обеих осей). 

3) color = t, или colour = t, – установка цвета графика (самое простое − 

придать t значение цвета на английском языке, например, black – черный, yellow 

– желтый, red − красный и т. д.), можно также использовать мощные инстру-

ментальные средства пакета ColorTools по  работе с цветом (см. справочные 

материалы Maple); 

4) coords = polar – построить график в полярной системе координат (по 

умолчанию − декартова), а если добавить еще параллельно опцию axescoordi-

nates = polar, то на чертеже будут изображены радиальные лучи; 

5) discont = t – указание разрывов функции на графике, например, для ви-

зуализации бесконечного разрыва или построения вертикальных асимптот 

t = true, а для выделения точек устранимого разрыва – t = [showremovable]; 

6) font = [f,style,size] – установка типа шрифта для вывода текста (f задает 

название шрифтов (Times, Courier, Helvetica, Symbol), style − стиль шрифта 

(bold, italic и др.), size – размер шрифта в pt); 

7) labels = [tx,ty] – надписи по осям координат (tx – по оси Оx, ty – по оси Оy); 

8) legend = ′text′ – название введенного графика; 

9) linestyle = n – тип линии графика (solid − непрерывная, dot − точечная, 

dash − пунктирная и т. д.), всего их семь, но вместо названия можно вводить соот-

ветствующий номер от 1 до 7 (n = 1– непрерывная, значение по умолчанию); 

10) numpoints = n – минимальное количество генерируемых точек для по-

строения графика (по умолчанию n = 200), которое в случае необходимости 

увеличивается автоматически системой; 
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11) scaling = t – установка масштаба рисунка (значение t = constrained – 

одинаковый масштаб по осям, unconstrained (по умолчанию) – график масшта-

бируется по размерам окна); 

12) style = t – вывод графика в виде линии (значение t = polygonoutline по 

умолчанию, line или polygon) или в виде точек (t = point); 

13) symbol = t – фигура, которой помечают точки графика (asterisk, box, 

circle, cross, diamond, point и др.); 

14) tickmarks = [m,n] – количество числовых меток по оси Оx и оси Оy со-

ответственно; 

15) thickness = n, где n = 0, 1, 2, 3… − толщина линии (по умолчанию n = 1); 

16) title = ′text′, где text − заголовок рисунка (текст можно оставлять без 

кавычек, если он не содержит математических выражений). 

Это далеко не полный перечень всех графических опций. Для более де-

тального изучения возможностей системы можно обратиться к справочной системе. 

Графики нескольких явно заданных кривых 

Для построения нескольких графиков в одной системе координат можно 

использовать следующий формат команды plot и ее параметров: plot([y1(x),…, 

yk(x)], options). Ввод выражений для функций и соответствующие им значения 

параметров осуществляются как списки. Построим в одной системе координат 

график функции 
32cosy x  и ее производной и укажем с помощью параметра 

legend уравнения кривых для соответствующего цвета линии: 

>  
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График параметрически заданной кривой 

С помощью команды plot можно построить график параметрически заданной 

функции 
( ),

( ), [ , ]

x x t

y y t t a b




 
, используя формат plot([x(t),y(t),t=a..b], options): 

>  

 

График неявно заданной кривой 

Для построения графика неявно заданной в прямоугольных координатах 

функции ( , ) 0F x y   может быть использована команда implicitplot из графиче-

ского пакета plots. Напомним, что для вызова команды из специализированного 

пакета есть две формы. Короткая форма состоит из имени и аргументов коман-

ды: implicitplot(F(x,y)=0, x=a..b, y=c(x)..d(x),options). Ее применение возможно 

после подключения всего пакета инструкцией with(plots) или только этой одной 

команды with(plots,implicitplot). Более длинная форма записи не требует пред-

варительного применения команды with(), а именно: plots[implicitplot](F(x,y)=0, 

x=a..b, y=c(x)..d(x),options). 

График явно заданной кривой в полярных координатах 

Выше упоминалась возможность построения графика функции ρ = ρ(φ), 

явно заданной полярными координатами, с помощью специальных значений 

параметров команды plot. Кроме описанного способа, график можно построить с 

использованием команды polarplot из пакета plots: plots[polarplot](ρ(φ), options): 

>  
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Диапазон изменения полярного угла по умолчанию изменяется от 0 до 2π. 

Подробное описание возможных значений дополнительных параметров дано в 

справочной системе с примерами их использования.  

График параметрически заданной кривой в полярных координатах 

Формат команды для построения графика функции 
ρ ρ( ),

φ φ( ), ..




 

t

t t a b
анало-

гичен команде построения параметрически заданной функции в декартовых ко-

ординатах: plots[polarplot]([ ( ), ( ), ..t t t a b   ], options): 

>  
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Если убрать оси, то можно использовать эти команды для создания раз-

нообразных рисунков: 

>  

 
График множества точек 

Для построения множества точек в пакете plots есть команда 

pointplot([[x1,y1],[x2,y2],…,[xk,yk]], options). По умолчанию точки не соединяются 

линией. Для использования дополнительных параметров управления качеством 

изображения в справочной системе есть полное описание значений опций, а в 

самой системе много интерактивных средств для этого (контекстное меню, 

специальные пакеты, например, CurveFitting). 

Текстовые комментарии на изображении 

В пакете plots имеется команда textplot для вывода текстовых коммента-

риев на рисунок: textplot([x,y,′text′], options), где x, y – координаты точки, по ко-

торой центрируется надпись ′text′. Например, 

>  
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Для управления изображением существует много параметров, подробно 

описанных в справочной системе. 

Несколько графических объектов на одном рисунке 

Часто бывает необходимо совместить на одном рисунке несколько гра-

фических объектов, полученных при помощи различных команд. Для этого ре-

зультат действия команды присваивается некоторой переменной в инертной 

форме:  

> p:=plot(…):t:=textplot(…):imp:=implicitplot(…):pol:=polarplot(…): … 

Затем для вывода графических объектов на экран необходимо выполнить 

команду display(…) из пакета plots: 

> with(plots): display([p,t,imp,pol…], options). 

Двухмерная область, заданная неравенствами 

Если необходимо построить двухмерную область, заданную системой не-

равенств 1 1 2 2( , ) , ( , ) ,..., ( , )n nf x y c f x y c f x y c   , то для этого можно использо-

вать команду inequal из пакета plots. В команде inequal({f1(x,y)>c1,…,fn(x,y)>cn}, 

x = a..b, y = c..d, options) в фигурных скобках указывается система неравенств, 

определяющих область, затем диапазон изменения переменных и дополнительные 

параметры. Параметры регулируют цвета открытых и закрытых границ, цвета 

внешней и внутренней областей, а также толщину линий границ, например: 

optionsfeasible = [color=red] – установка цвета внутренней области; 

optionsexcluded = [color = yellow] – установка цвета внешней области; 

optionsopen = [color = blue, thickness = 2] – установка цвета и толщины линии 

открытой границы; optionsclosed = [color = green,thickness = 3] – установка цве-

та и толщины линии закрытой границы. 
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3.2. Геометрические построения в пространстве 

 

График заданной явно поверхности 

График функции ( , )z f x y  можно изобразить, используя команду 

plot3d(f(x,y), x = a..b, y = c..d, options). Параметры этой команды частично сов-

падают с параметрами команды plot. К часто используемым параметрам коман-

ды plot3d относится light = [angl1,angl2, c1, c2, c3] – задание подсветки поверх-

ности, создаваемой источником света из точки со сферическими координатами 

(angl1, angl2). Цвет определяется долями красного (c1), зеленого (c2) и синего 

(c3) цветов, которые находятся в интервале [0,1]. Используя контекстное меню, 

можно регулировать стиль изображения, качество и тон заполнителя, линии уров-

ня и т. д. 

Графики нескольких явно заданных поверхностей 

Для построения нескольких графиков в одной системе координат можно 

использовать следующий формат команды plot3d и ее параметров: 

plot3d([z1(x,y),…, zk(x,y)], x=a..b,y=c..d, options). Ввод выражений для функций и 

значения параметров осуществляется как список. 
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График заданной параметрически поверхности 

Если требуется построить поверхность, заданную параметрически урав-

нениями x = x(u,v), y = y(u,v), z = z(u,v), то эти функции перечисляются в квад-

ратных скобках в команде: plot3d([x(u,v), y(u,v), z(u,v)], u = a..b, v = c..d). 

График неявно заданной поверхности 

Трехмерный график поверхности, заданной неявно уравнением 

( , , ) 0F x y z  , строится с помощью команды пакета plots: 

implicitplot3d(F(x,y,z) = 0, x = a..b, y = c..d, z = e..f), где указывается уравнение 

поверхности ( , , ) 0F x y z   и размеры рисунка по координатным осям. 

График пространственных кривых 

В пакете plots имеется команда spacecurve для построения простран-

ственной кривой, заданной параметрически: ( ), ( ), ( )x x t y y t z z t   . Ее ком-

пактный формат spacecurve([x(t),y(t),z(t)],t = a..b, options). 

3.3. Анимация 

 

Maple позволяет выводить на экран движущиеся изображения с помощью 

команд animate (для двухмерного случая) и animate3d (для трехмерного случая) из 

пакета plots. Имеется в виду следующее: если некоторая функция зависит от до-

полнительного параметра (например времени), эти команды позволяют сформи-

ровать совокупность кадров в диапазоне его изменения, а затем последовательно 

их отобразить друг за другом с определенной частотой. Для проигрывания резуль-

тата нужно выделить график, который появится после выполнения команды, и 

воспользоваться кнопками контекстной панели анимации или правой кнопкой 

мыши для вызова контекстного меню. Функции кнопок можно уточнить по 

всплывающим подсказкам, которые появляются при наведении на них указателя 

мыши. 

Наиболее простой вариант создания объекта двухмерной анимации – ис-

пользование команды со следующим синтаксисом: animate(f(x,t), x=x1.. x2, t=t1.. t2, 
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options), где f(x,t) – аналитическое выражение, явно задающее функцию y=f(x,t), 

которая зависит от переменной x и параметра t; x=x1.. x2 – диапазон изменения 

переменной x; t=t1.. t2 – диапазон изменения параметра t; options – дополни-

тельные опции команды. Рассмотрим в качестве примера анимационное отоб-

ражение функции 
1

1
y

tx



 в зависимости от коэффициента при x: 

>  

 
 

В области вывода появился график функции при t = 1 (первое значение 

параметра из заданного промежутка), который нужно выделить с помощью 

мыши для вызова контекстной панели средств анимации. По умолчанию будет 

показано динамическое изображение 16 кадров. Их число можно изменить с 

помощью опции frames. 

Можно создавать анимацию также для параметрически заданной кривой, 

для кривой в полярной системе координат, для множества точек, изменяющих-

ся по определенному правилу. Ниже приведены примеры команд для разных 

случаев (выполните команды как упражнения и «проиграйте» результат): 
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В пространстве анимацию можно создать как с использованием команды 

animate() со специальным синтаксисом, так и с помощью animate3d(): 

 

 

Анимационные команды могут одновременно отображать изменение не-

скольких функций. Все они при этом должны зависеть от одних и тех же неза-

висимых аргументов и одного параметра. 

Проследить в динамике за построением графика кривой можно также, 

используя команду animatecurve() этого же пакета: 

.
 

Упражнения 

 

1. Выполните все примеры разд. 3. Измените характеристики полученных 

графических объектов с помощью контекстной панели инструментов и кон-

текстного меню. Задайте дополнительные опции команд, используя при необ-

ходимости справочные материалы Maple.  

2. Исследуйте изменение графика равносторонней гиперболы в зависимо-

сти от значений полуосей.  

Указание. Можете использовать, например, такую команду: 
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3. Проследите движение какой-либо кривой по поверхности 

2 21 2z x y   . 

Указание. Можете использовать, например, такие инструкции: 
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4. Математический анализ 

 

В Maple для некоторых математических операций существует по две ко-

манды: одна прямого, а другая – отложенного (инертного) исполнения. Имена 

функций для этих команд состоят из одинаковых букв, за исключением первой: 

команды прямого исполнения начинаются со строчной буквы, а команды отло-

женного исполнения – с прописной. После обращения к команде отложенного 

действия математические операции (предел, производная, интеграл и т. д.) вы-

водятся на экран в виде стандартной аналитической записи, и вычисление в 

этом случае сразу не производится. Команда прямого исполнения выдает ре-

зультат немедленно. 

 

4.1. Функции и способы их задания 

 

Рассмотрим некоторые подходы к определению математических функций 

в Maple. 

1. Задание функции с помощью оператора присваивания <:=>, когда не-

которому выражению, зависящему от одной или нескольких переменных, при-

сваивается имя, например: 

>  

 

>  

 

При этом способе задания для вычисления значений функции в конкрет-

ных точках или замены переменной алгебраическим выражением требуется ис-

пользование команд подстановки subs(x1=a,…,xn=b, имя_функции): 

>  

17 

>  
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>  

 

2. Определение функции с помощью оператора, который ставит в соот-

ветствие набору переменных (x1,…,xn) выражение expr, от них зависящее. Это 

соответствие можно задать с помощью стрелки, которая вводится с помощью 

последовательного нажатия клавиш <-> и <>> или выбора из палитры Arrows: 

>  

>  

 

При таком задании функции ее значение при конкретных наборах пере-

менных можно получить привычным в математике способом: 

>  

 

3. Преобразовать выражение в функциональный оператор можно с помо-

щью команды unapply(expr,x1,…,xn): 

>  

 

>  

 

4. Для ввода кусочно-непрерывной функции можно использовать оператор 

условного перехода if или команду piecewise(cond_1,expr_1,…, 

cond_n,expr_n,expr), где cond_i задают условия, при котором функция опреде-

ляется как expr_i, expr – выражение (по умолчанию 0) для задания функции на 

оставшейся части области определения. Приведем пример задания такой функ-

ции и построения графика: 

>  
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>  

 
 

Если необходимо в таком формате определить некоторые пороговые 

функции, то можно использовать команду convert: 

>  

 

>  

 

>  

 

5. Удобно также для аналитического задания математической функции ис-

пользовать процедуру программирования: 

Имя_функции:=proc(arguments) expr end proc; 

Приведем пример: 

>  

 

>  
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4.2. Пределы и производные 

 

Вычисление пределов 

Для вычисления предела lim ( )
x a

f x


 функции ( )y f x  в точке x a  име-

ются две команды: прямого исполнения – limit(f(x), x=a, options) и отложенного – 

Limit(f(x), x=a,options). Их обязательными аргументами являются аналитиче-

ское выражение f(x) для задания функции и значение точки a, в которой вычис-

ляется предел. К числу необязательных параметров options относятся значения 

для поиска односторонних пределов (left – слева, right – справа), а также для 

указания типа переменной (real – действительная, complex – комплексная). 

С помощью этих двух команд принято записывать математические вы-

кладки в стандартном аналитическом виде, например: 

>  

   
    

(   ) (
 

 
        ( ))     

>  

 

>  

 

>  

   
    

({ 
        
         

)    

>  

   
    

({ 
        
         

)    

Би
бл
ио
те
ка

 БГ
УИ
Р



 

62 

 

>  

 

 
 

Для исследования функции на непрерывность на заданном интервале (в 

том числе и бесконечном) можно использовать команду iscont(), которая воз-

вращает логическое значение true в случае непрерывности, и false – в против-

ном случае. Если промежуток, на котором устанавливается непрерывность, яв-

ляется замкнутым отрезком, то к аргументам команды следует добавить необя-

зательный параметр 'closed ': 

>  

 

 

 

 

 

Для определения значений переменных, где нарушается непрерывность 

функции, можно использовать команду discount(): 

>  
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Вычисление производных 

Для вычисления производной ( )f x  функции ( )y f x  в Maple имеются 

две команды: прямого исполнения – diff(f, x) и отложенного исполнения – Diff(f,  x). 

Их обязательными аргументами являются аналитическое выражение f(x) для 

задания функции и переменная, по которой проводится дифференцирование. 

После выполнения дифференцирования полученное выражение можно упро-

стить, используя, например, команды simplify, factor, combine или expand: 

>  

 

>  

 

Для вычисления производных старших порядков следует указать в пара-

метрах команды x$n, где n – порядок производной; например: 

>  

 

>  

. 

В следующем примере сравните результаты, которые получаются в ре-

зультате применения разных команд упрощения к преобразованию производ-

ной четвертого порядка: 

>  
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Команду diff можно применить и к функции нескольких переменных для 

нахождения частных производных. Для этого используется следующий ее фор-

мат: diff(f,x1$n1,…, xk$nk). Упростим результат нахождения смешанной произ-

водной шестого порядка: 

>  

 

 

Дифференциальный оператор 

Для определения дифференциального оператора функции ( )y f x  ис-

пользуется команда D(f). Например: 

>  

 

Тогда для вычисления производной в точке можно применить привычную 

запись: 

>  

 

Оператор дифференцирования применяется к функциональным операто-

рам: 

>  

 

 

Для производной порядка n можно использовать привычную математиче-

скую запись 
( )D ( )n f : 

>  

 

>  

 

Экстремум функции 

Для нахождения экстремума функции на заданном промежутке исполь-

зуются команды minimize(expr,x=a..b) и maximize(expr,x=a..b). По умолчанию, 

если не указан диапазон изменения переменной, рассматривается область опре-
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деления функции, заданной с помощью выражения expr. Для получения точки 

минимума или максимума на отрезке добавляется параметр команды location: 

>  

 

>  

 

>  

 

>  

 

 

Экстремальные значения функции нескольких переменных можно опре-

делить командой extrema(expr,{cond_1,…,cond_k},{x1,…,xn}). Здесь expr –

выражение, определяющее функцию n переменных x1,…,xn, второй аргумент – 

множество ограничений на переменные при нахождении условного экстремума. 

Если таких ограничений нет, вводится просто пара пустых фигурных скобок. В 

приведенном ниже примере находится глобальный экстремум функции двух 

переменных, а затем с использованием необходимого условия экстремума 

(частные производные равны нулю) находятся точки, в которых он достигается: 

>  

 

>  

 

>  

 

Аналогично можно решить задачу на условный экстремум: 

>  

 

Если добавить необязательный параметр 's' в аргументы команды, то вы-

ведутся точки экстремума в виде множества: 

Би
бл
ио
те
ка

 БГ
УИ
Р



 

66 

 

>  

 

 

Задача нахождения точек минимума и максимума будет равносильна ре-

шению системы трех уравнений: 

>  

 

>  

 

 

4.3. Интегралы 

 

Аналитическое интегрирование 

Для нахождения неопределенного интеграла ( )f x dx можно использовать 

две команды: прямого исполнения – int(f(x), x) и отложенного – Int(f(x), x). Их 

обязательными аргументами являются аналитическое выражение f(x) для зада-

ния подынтегральной функции и переменная интегрирования x. 

Для вычисления определенного интеграла ( )

b

a

f x dx  в командах int и Int до-

бавляются пределы интегрирования, например: 

>  

 

Несобственные интегралы 

Для исследования сходимости несобственного интеграла с бесконечными 

пределами интегрирования в параметрах команды int необходимо указывать 

соответствующий диапазон изменения переменной интегрирования, например, 

x=0..+infinity. 

>  
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Если интеграл не сходится к конечному значению, то в ответе будет ∞: 

>  

 

Для исследования несобственных интегралов от неограниченных функций 

в команде интегрирования нужно добавить параметр continuous. В этом случае 

Maple будет игнорировать любые возможные разрывы подынтегральной функ-

ции в отрезке интегрирования. Сравните: 

>  

 

>  

 

Если функция не определена хотя бы в одной точке отрезка интегрирова-

ния, то ответом будет undefined: 

>  

 

>  

 

Для нахождения приближенного числового значения интеграла можно, 

как и ранее, воспользоваться evalf-функцией: evalf(int(f(x), x=a..b), n), где n – 

количество значащих цифр результата вычислений. 
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Интегралы, зависящие от параметра 

Если требуется вычислить интеграл, зависящий от параметра, то часто его 

значение может зависеть от знака этого параметра или каких-либо других огра-

ничений. Рассмотрим в качестве примера интеграл 

1

a

dx

x



 , который сходится 

при а > 1 и расходится при 1a  . Если ввести непосредственно команду инте-

грирования, то получим следующий результат: 

>

 

 

 

>

 

 

 

Это еще не тот ответ, который нужен. Очевидно, для получения явного 

аналитического результата вычислений следует сделать какие-либо предполо-

жения о значении параметра a, то есть наложить на него ограничения в виде 

неравенств. Это можно сделать при помощи команды assume(ineq1), где ineq1 – 

простейшее неравенство относительно параметра. Если нужно использовать 

двойное неравенство, то дополнительные ограничения вводятся с помощью ко-

манды additionally(ineq2), где ineq2 – второе неравенство, ограничивающее зна-

чение параметра с другой стороны. После наложения ограничений на параметр 

Maple добавляет к его имени символ (~). Например, параметр a, на который 

были наложены некоторые ограничения, в строке вывода будет иметь вид a~. 

Для описания наложенных ограничений параметра a можно использовать ко-

манду about(a). Например, наложить ограничения на параметр a такие, что 

1 5a  , а затем убедиться в этом назначении, можно следующим образом: 

>  

Originally a, renamed a~: 
  is assumed to be: RealRange(1,Open(5)) 
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Вернемся к вычислению интеграла 

1

a

dx

x



 , присвоив параметру значения, 

большие 1: 

>  

 

Основные методы интегрирования 

Для нахождения интегралов можно использовать методы замены пере-

менной и интегрирование по частям с помощью команд пакета IntegrationTools 

соответственно Change и Parts. Если в интеграле требуется сделать замену пе-

ременных t=h(x), то параметры команды замены переменных такие: 

Сhange(h(x)=t, Int(f(x), x), t), где t  новая переменная. Команда интегрирования 

по частям: Parts(Int(f(x), x), u(x)), где u(x) – функция, производную от которой 

предстоит вычислить по формуле интегрирования по частям. 

Пошаговое интегрирование 

В Maple имеется пакет Student, предназначенный для обучения математи-

ке. Он содержит набор команд, разбитых по темам и предназначенных для вы-

полнения расчетов шаг за шагом так, чтобы была понятна последовательность 

действий, приводящих к результату. Их можно использовать непосредственно, 

подключив нужные библиотеки, или вызвать из главного меню вкладку Tools → 

Tutors →… с различными графическими интерактивными приложениями для 

решения нужных задач. 

Численное интегрирование 

Численное интегрирование можно выполнить командой evalf(int(f(x), 

x=a..b),n), где n – точность вычислений (число значащих цифр в результате): 

>  

 

Кроме этого, можно использовать в команде int формат с плавающей точ-

кой при вводе чисел: 
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>  

 

Для выбора аналитического или численного способа интегрирования в 

параметрах команды int предусмотрена также опция numeric со значениями 

false или true cоответственно. Сравните: 

>  

 

>  

 

Создание процедур в Maple 

Как ранее упоминалось, в Maple имеется возможность создавать соб-

ственные процедуры. Процедура начинается с заголовка, который состоит из 

имени (его пользователь определяет сам), оператора присваивания <:=> и слу-

жебного слова proc, после которого в круглых скобках через запятую указыва-

ются формальные параметры процедуры.  

Во избежание неполадок работы процедуры рекомендуется в строке ее заго-

ловка описать переменные, которые будут использоваться только внутри тела про-

цедуры (локальные переменные). Для этого используется служебное слово local, по-

сле которого через запятую перечисляются переменные, наделенные этим качеством.  

После заголовка идет основное тело процедуры, состоящее из составлен-

ных пользователем команд, причем последняя команда будет выводить оконча-

тельный результат выполнения процедуры (или для этих целей может быть ис-

пользована команда return). Заканчивается текст процедуры служебным слово-

сочетанием end proc. Общий вид процедуры (стандартный синтаксис): 

> name:=proc(var1, var2, …) local vloc1, vloc2,…; 

> com1; 

> com2; 

…………… 

> comn; 

> end proc; 
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Порядок обращения к процедуре такой: name(v1,v2,…), где v1,v2,… − зна-

чения формальных аргументов процедуры. 

Приведем простой пример создания процедуры численного интегрирова-

ния с помощью формулы прямоугольников. В качестве формальных парамет-

ров возьмем подынтегральную функцию, левый, правый конец промежутка ин-

тегрирования и количество n частичных интервалов его разбиения. Обратимся к 

процедуре с разными значениями для n и сравним полученные результаты с 

«точным» решением: 

>  

>  

 

>  

 

>  

 

>  

 

>  

 

Кратные интегралы 

Для вычисления кратных интегралов можно использовать команду int со 

специальными аргументами: 

>  
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>  

 

Можно эту команду также применять повторно: 

>  

 

Для вычисления двойных интегралов ( , )

D

f x y dxdy  область интегрирова-

ния D, может быть задана в следующих форматах: 

1) [x=х1..х2, y=y1..y2] − прямоугольная область интегрирования; 

2) [y=f1(x)..f2(x), x=х1..х2], где y=f1(x) и y=f2(x)  линии, ограничивающие 

область интегрирования «снизу» и «сверху» на интервале [х1, х2]; 

3) [x=g1(y)..g2(y), y=y1..y2], где g1(y) и g2(y)  линии, ограничивающие об-

ласть интегрирования «слева» и «справа» на интервале [y1, y2]. 

Приведем примеры вычисления интегралов в случае разных способов за-

дания области интегрирования: 

>  
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>  

 

>  

 
 

>  

 

>  

 
 

>  

 

Аналогично с помощью команды int вычисляются n-кратные интегралы 

при n > 2. 
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4.4. Ряды 

 

Вычисление суммы и произведения членов последовательности 

Конечные и бесконечные суммы ( )
b

n a

f n


  вычисляются командой sum 

прямого исполнения и Sum − отложенного. Аргументы этих команд одинако-

вые: sum(f(n), n=a..b). Если требуется вычислить сумму бесконечного ряда, то в 

качестве верхнего предела индекса вводится infinity. 

Аналогичным образом вычисляются произведения ( )
b

n a

f n


  командами 

product(f(n),n=a..b) прямого и Product(P(n),n=a..b) − отложенного действий. 

Разложение функции в степенной ряд 

Разложение функции f(x) в степенной ряд 
0

( ) (( ) )
n

k n
k

k

a x a o x a


    в 

окрестности точки а осуществляется командой series(f(x), x=a, n) или taylor(f(x), 

x=a, n).  

Команды series и taylor выдают результат, имеющий тип series. Для того 

чтобы иметь возможность дальнейшей работы с полученным разложением как 

с многочленом, его следует преобразовать в полином с помощью команды 

convert(%,polynom). Например: 

>  

 

 

 

 

Функцию f(x1,…,xn) n переменных можно представить в виде многочлена 

Тейлора в окрестности точки (a1,…,an) порядка n с помощью команды 

mtaylor(f(x1,…,xn), [x1= a1,…,xn= an], n): 

>  
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Для работы с формальными степенными рядами предназначен пакет 

powseries. Для численной аппроксимации функций на интервале могут быть 

использованы команды из пакета numapprox. 

 

4.5. Обыкновенные дифференциальные уравнения 

 

Для решения обыкновенных дифференциальных уравнений (ОДУ) в Ma-

ple имеется команда dsolve(), которая пытается найти общее решение в анали-

тическом виде, и пакет DEtools с возможностями численного решения задачи 

Коши и мощной графикой. Кроме того, Maple позволяет эффективно получить 

приближенное аналитическое решение с помощью подходящих рядов. Для ре-

шения дифференциальных уравнений в частных производных можно обратить-

ся к пакету PDEtools. 

Аналитическое решение ОДУ и их систем 

Для нахождения в Maple общего решения в символьном виде можно при-

менить команду dsolve() в следующем формате: dsolve(DEq, options), где DEq – 

ОДУ, options – дополнительные (необязательные) параметры. Они могут ука-

зывать метод решения задачи. По умолчанию ищется аналитическое решение, 

для чего может быть использован аргумент команды type=exact. При составле-

нии дифференциальных уравнений для обозначения производной применяется 

команда diff: 

>  

 

Общее решение ОДУ зависит от произвольных постоянных, число кото-

рых равно порядку дифференциального уравнения. В  Maple такие константы 

обозначаются как _С1, _С2 и т. д. 

Общее решение неоднородного линейного дифференциального уравне-

ния выводится в виде суммы его частного решения (без произвольных постоян-
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ных) и общего решения соответствующего однородного дифференциального 

уравнения (с произвольными постоянными): 

>  

 

 

Команда dsolve выдает решение дифференциального уравнения в невы-

числяемом формате. Для дальнейшей работы с решением можно отделить пра-

вую часть полученного равенства командой rhs(%). Например, построим гра-

фик полученной функции при _C1=1, _C2=0: 

 

>  

 

>  

 

>  

 

 
Команда dsolve представляет возможность найти фундаментальную си-

стему решений (базисные функции) ОДУ. Для этого в параметрах команды 

dsolve следует указать output=basis: 

>  

 

 

Би
бл
ио
те
ка

 БГ
УИ
Р



 

77 

 

Команда dsolve может найти решение задачи Коши, если помимо диффе-

ренциального уравнения задать начальные условия для искомой функции. Для 

обозначения производных в начальных условиях используется дифференциаль-

ный оператор D. Например, условие (1) 2y   следует записать в виде 

. 

Команда dsolve может найти решение системы обыкновенных дифферен-

циальных уравнений, если использовать следующий ее формат: 

dsolve({de1,de2,…,den},{x(t),…,y(t)}), где {de1,de2,…,den}  множество уравне-

ний, входящих в заданную систему, x(t),…,y(t)  неизвестные функции. 

Найдем решение системы дифференциальных уравнений относительно 

двух неизвестных функций: 

>  

 

>  

 

Найдены две функции x(t) и y(t), которые зависят от двух произвольных 

постоянных _С1 и _С2. 

Заметим, что переменные x и y заданной системы необходимо вводить 

как функции независимого аргумента t, то есть в виде x(t) и y(t) соответственно. 

Если этого не сделать, Maple выдаст ошибку: 

>  

 

>  

Error, (in dsolve) ambiguous input: the variables {x, y} and the 

functions {x(t), y(t)} cannot both appear in the system 

 

Приближенное решение ОДУ и их систем 

В случае, когда аналитическое решение дифференциального уравнения не 

может быть найдено, можно использовать разложение неизвестной функции в 

степенной ряд или численное приближение решения. 
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Чтобы найти приближенное решение дифференциального уравнения в ви-

де степенного ряда, в команде dsolve следует после переменных указать пара-

метр type=series (или просто series). Для того чтобы указать порядок n разложе-

ния, следует перед командой dsolve вставить его определение с помощью ко-

манды Order:=n. По умолчанию значение системной переменной Order равно 

шести. 

Если ищется общее решение дифференциального уравнения в виде разло-

жения в степенной ряд, то коэффициенты при степенях х найденного разложе-

ния будут содержать неизвестные значения y(0) функции в нуле и ее производ-

ных D(y)(0), (D
(2)
)(y)(0) и т. д. Полученное в строке вывода выражение будет 

иметь вид, похожий на разложение искомого решения в ряд Маклорена, но с 

другими коэффициентами при степенях х. Для выделения частного решения 

следует задать начальные условия y(0)=у0, D(y)(0)=у1, (D
(2)

)(y)(0)=у2 и т. д., 

причем количество этих начальных условий должно совпадать с порядком со-

ответствующего дифференциального уравнения. 

Разложение в степенной ряд имеет тип series, поэтому напомним, что для 

дальнейшей работы с этим рядом его следует преобразовать в полином с помо-

щью команды convert(%,polynom), а затем выделить правую часть полученного 

выражения командой rhs(%). 

Найдем точное и приближенное в виде степенного ряда до четвертого по-

рядка решения ОДУ cosy y x x   . Сравним их при начальных условиях 

(0) 1, (0) 1, (0) 2y y y    , построив соответствующие графики в одной системе 

координат. Используем следующий набор команд Maple: 

>  
>  
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>  

 

 

>  

 

 

 

>  

 

 
 

На рисунке видно, что наилучшее приближение точного решения степен-

ным рядом достигается примерно на интервале (1 <x <1). 

Численное решение дифференциальных уравнений 

Для того чтобы найти численное решение дифференциального уравнения 

(задачи Коши или краевой задачи) в команде dsolve следует указать параметр 

type=numeric (или просто numeric). Тогда команда решения дифференциального 

уравнения будет иметь вид dsolve(de, var, type=numeric, options), где de – урав-

нениe, var – неизвестная функция, options – параметры, позволяющие указать 

метод численного интегрирования дифференциального уравнения. В Maple ре-
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ализованы следующие методы: method=rkf45  метод Рунге – Кутта – Фельберга 

четвертого и пятого порядка (установлен по умолчанию); method=dverk78 – ме-

тод Рунге – Кутта седьмого и восьмого порядка; method=classical – классиче-

ский метод Рунге – Кутта третьего порядка; method=gear и method=mgear – од-

ношаговый и многошаговый методы Гира. 

График численного решения дифференциального уравнения можно по-

строить с помощью команды odeplot(dsn, [x,y(x)], x=x1..x2), где в качестве вы-

ражения используется результат команды dsn:=dsolve({de,cond}, y(x), numeric) 

численного решения, после нее в квадратных скобках указывают переменную и 

неизвестную функцию [x,y(x)], а также интервал x=x1..x2 для построения гра-

фика. Заметим, что требуется подключение пакета plots для ее выполнения. 

Найдем численное решение уравнения 2y xy    при условии (0) 1y   и 

сравним с точным, построив графики: 

>  

 

>  

>  

>  

 

 
 

Видим, что найденные решения практически совпадают. 
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Формат команды dsolve для численного решения системы ОДУ отличается 

незначительно: dsolve({sde, cond},{vars}, type=numeric, options), где sde – мно-

жество уравнений системы, cond – начальные условия, vars – множество неиз-

вестных функций, options – параметры, позволяющие указать метод численного 

интегрирования дифференциальных уравнений. 

Найдем решение системы ( ) ( )cos( ) ( ), ( ) sin( )x t y t t x t y t t t      ОДУ с 

начальными условиями (0) 1, (0) 2x y   с помощью численного метода и по-

строим графики найденных функций в одной системе координат: 

>  

>  

 

 
 

Для численного решения задачи Коши, построения графиков решения и 

фазовых портретов в Maple имеется специальный пакет DEtools.  

Команда DEplot из пакета DEtools строит численными методами графики 

решения или фазовые портреты. Эта команда аналогична команде odeplot, но 

более функциональна: она сама производит численное решение дифференци-
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ального уравнения. Основные параметры DEplot похожи на параметры odeplot: 

DEplot(sde, vars, range, x=х1..х2,…, y=у1..у2, cond, options), где sde  система 

дифференциальных уравнений (или одно уравнение); vars – множество неиз-

вестных функций (или одна функция); range – диапазон изменения независи-

мой переменной; cond – начальные условия; x=х1..х2 и y=у1..у2 – диапазоны 

изменения функций; options – дополнительные (необязательные) параметры. 

Наиболее востребованные параметры: linecolor − цвет линии; 

scene=[x,y]  определение зависимости для вывода графика; iterations=n − чис-

ло итераций, необходимое для повышения точности вычислений (по умолча-

нию n = 1); stepsize=number − число, равное расстоянию между точками на гра-

фике (по умолчанию number= (x2x1)/48); obsrange=true/false  указатель пре-

рывания вычислений в случае выхода графика решения за установленный диа-

пазон (по умолчанию имеет значение true ); различные параметры для анима-

ции (см. справочные материалы о команде). 

Построим график решения дифференциального уравнения 

2 0y xy x y     с начальными условиями (0) 0, (0) 1y y   в интервале [ 4;5] . 

>  

  
 

 
 
>  
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С помощью команды DEplot можно построить фазовый портрет для си-

стемы двух дифференциальных уравнений 1 2( ) ( , , ), ( ) ( , , )x t f t x y y t f t x y   , ес-

ли в параметрах данной команды указать значение scene=[x,y].  

Если система дифференциальных уравнений является автономной, то на 

фазовом портрете будет построено поле направлений в виде стрелок. Размер 

стрелок регулируется параметром arrows. 

Для того чтобы нарисовать весь фазовый портрет, необходимо для каждой 

фазовой траектории указывать начальные условия: например, для системы двух 

дифференциальных уравнений первого порядка несколько начальных условий в 

команде DEplot указываются после задания диапазона изменения независимой 

переменной t: [[x(t0)=x0, y(t0)=y0], [x(t0)=x1, y(t0)=y1],…].  

Начальные условия можно задавать в более компактной форме: [t0, x0, y0], 

где t0  точка, в которой задаются начальные условия, x0 и y0  значения иско-

мых функций в точке t0. 

Фазовый протрет системы двух дифференциальных уравнений первого 

порядка можно также построить с помощью команды phaseportrait(sde, 

[x,y],x1..x2,[[cond]]), где sde  система двух дифференциальных уравнений пер-

вого порядка, [x,y]  имена искомых функций, x1..x2  интервал, на котором 

следует построить фазовый портрет, а в скобках указываются начальные усло-

вия. 

Напомним, что рассмотренные команды находятся в пакете DEtools, кото-

рый должен быть предварительно загружен. 

Построим с помощью команды DEplot фазовый портрет системы диффе-

ренциальных уравнений 
31

,
2

x y y x x     для нескольких наборов начальных 

условий: х(0)=1, у(0)=0.2; х(0)=0, у(0)=1; х(0)=1, у(0)=0.4. 

>  
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>  

 

Приведем пример решения аналогичной задачи с использованием коман-

ды phaseportrait (определите по тексту программы систему и начальные дан-

ные): 

>  

>  
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Заметим, что при вводе последней системы использовались дифференци-

альные операторы D(f). Предлагается проследить за изменением рисунка при 

задании других начальных условий, диапазона изменения переменной и разме-

ров координатных осей.  

Наконец, приведем пример системы с тремя неизвестными функциями 

( ), ( ), ( )x t y t z t , отражающий зависимость z от x (параметр scene команды 

phaseportrait): 

> 

 

 
 

Упражнения 

 

1. Задайте разными способами функцию ( )y f x , найдите ее значение в 

точке 0x  и постройте график, если: 

1) 
3 2

02 , 2xy x   ;     2) 5
1
, 10

2

x
y x

x


  ;     3) 0| 3 | | 3|, 7y x x x     . 

2. Задайте функцию 
2

2 , 1,

1, 1.

x x
y

x x

  
 

  

 Исследуйте ее на непрерывность в 

точке 1x    и постройте график. 
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3. Вычислите пределы и выведите ответ в виде равенства 

0

lim ( ) " "
x x

f x результат


 : 

1) 
10

1
lim

2 3
x

x




;       2) 
1

π
lim(1 )tg

2


x

x
x ;        3) 

2 0

1
lim arctg

2  x x
. 

4. Вычислите производную функции 3 3cos 2 sin 2y x x   при 
π

6
x . 

5. Найдите производные n-го порядка для следующих функций (при 

необходимости упростите результат): 

1) 
ln( 2)

, 3
2

x
y n

x


 


; 2) 3 2 1(4 5) , 5xy x e n   ; 3) 2(1 )arctg , 3  y x x n

. 

6. Найдите неопределенные интегралы:  

1) 
4

2 2 3

3 5

( 1)

x
dx

x x




 ;     2) 

2

2

arcsin 1

1

x
dx

x




 ;     3) sin sin2 sin3x x xdx .  

7. Вычислите определенные интегралы: 

1) 

8 2

3 2
1

ln xdx

x
 ;               2) 

0

2
1

tg( 1)

cos ( 1)







x dx

x
;            3) 

3
3 3

2
0 (3 ) 9

x

xe
dx

x x





 
 . 

8. Вычислите определенный интеграл 

π

2

2 2 2 2 3
0

sin cos

( sin cos )


x xdx

a x b x
 при поло-

жительных значениях входящих в него параметров. 

Указание. Перед вычислением интеграла введите ограничения на пара-

метры с помощью команд assume (a > 0); assume (b > 0). 

9. Найдите несобственный интеграл 

2

2

0

1 ax

x

e
dx

xe

 
  при различных ограни-

чениях на параметр. В частности при 1a   . 

10. Найдите численное значение интегралов: 
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1) 

2

1

sin x
dx

x ;         2) 
2

3
( 1)

2

xe dx 
 . 

11. Полностью проделайте все этапы вычисления интеграла 2lnx xdx  по 

частям. 

12. Вычислите интеграл 

π/2

0
1 cos

dx

x
 с помощью универсальной тригоно-

метрической подстановки tg
2


x
t . 

13. Найдите n-частичную и полную суммы ряда, общий член которого ра-

вен 
1

(3 1)(3 2)
na

n n


 
. 

Указание. Воспользуйтесь командами sum  и limit. 

14. Найдите сумму степенного ряда 2

1

( 1)n n

n

n x




 . 

15. Найдите точное приближенное значение бесконечного произведения 

2

2
3

1

1n

n

n








 . 

16. Разложите в степенной ряд Маклорена функцию 
2 3 1xy e x  , оста-

вив пять первых членов. 

17. Постройте на одном рисунке графики интеграла 
2 /2

0

x
te dt

  и его мно-

гочлена Тейлора пятого порядка в окрестности нуля. 

18. Представьте функцию 
2 2( , ) cos(3 )f x y x y   в виде многочлена Тей-

лора шестого порядка в окрестности точки (0, 0). 

19. Вычислите повторный интеграл 

4 3

2 2
2 0

.


 
y

y dx
dy

x y
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20. Вычислите двойной интеграл 
2 /4xy

D

y e dxdy
  по области, ограничен-

ной линиями 0, 2,x y y x   .  

21. Вычислите тройной интеграл 
2

V

x zdxdydz  по области, ограниченной 

поверхностями 3 , , 2, , 0y x y o x z xy z     . 

22. Разложите в ряд Фурье функцию y x , заданную на интервале ( π,π) . 

Постройте в одной системе координат графики заданной функции и суммы ря-

да с разной точностью приближения. 

23. Найдите общее решение дифференциальных уравнений:  

1) cos sin2y y x x   ;                2) 2 sin xy y y x e     . 

24. Найдите фундаментальную систему решений дифференциального 

уравнения 2 0IVy y y   . 

25. Найдите решение задачи Коши 2sin , (0) 1, (0) 1, (0) 2y y x y y y         . 

26. Найдите решение системы дифференциальных уравнений 

5 2 0,

3 5 3 0

x x y y

x x y y

     


    
 

при начальных условиях (0) 1, (0) 0, (0) 1x x y   . 

27. Найдите решение задачи Коши , (0) 0yy y xe y     в виде степенного 

ряда с точностью до пятого порядка. 

28. Постройте график численного решения задачи Коши 

sin , (0) 1y xy y   . 

29. Постройте фазовый портрет системы дифференциальных уравнений  

3 4 ,

2 ,

x x y

y x y

  


  
 

подобрав различные начальные значения самостоятельно. 
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5. Линейная алгебра и аналитическая геометрия 

 

Для решения задач линейной (векторной и матричной) алгебры в Maple 

имеется специализированный пакет LinearAlgebra, который загружается коман-

дой with(LinearAlgebra)[;\:]. Если воспользоваться фиксатором точка с запятой (;), 

то более 100 команд пакета будут выведены на экран в алфавитном порядке. Их 

назначение интуитивно понятно, так как каждое имя команды представляет со-

бой слово, слова или их сокращение на английском языке. 

 

5.1. Векторы 

 

Способы задания векторов 

Для определения вектора в Maple можно использовать командуVec-

tor[column\row]([x1,x2,…,xn],options), где в квадратных скобках через запятую 

указываются координаты вектора: 

>  

 

Эта команда представляет собой одну из форм функции-конструктора 

Vector(…) c аргументом, представляющим собой непосредственное задание 

вектора с помощью списка. По умолчанию, это матрица-столбец. Для задания 

матрицы-строки можно добавить необязательный параметр row: 

>  

. 

Существует также совсем краткая форма в виде непосредственного ввода 

компонентов вектора в угловых скобках: 
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>  

 

Полное описание возможностей конструктора векторов можно найти в 

справочной системе с большим количеством примеров разных случаев. В дан-

ном учебно-методическом пособии будут также описаны дополнительные осо-

бенности для создания и работы со специальными матрицами, которые приме-

нимы и к векторам.  

Координату уже определенного вектора x можно получить, записав x[i], 

где i  номер координаты. Например, вторую координату вектора x можно вы-

вести так: 

>  

2 

Операции над векторами (табл. 5) 

Таблица 5 

Перечень операций над векторами 

Операция 
Математическая 

запись 
Maple-функция 

Краткая форма  

команды 

Сложение a b  Add(a, b), VectorAdd(a, b) a b  

Вычитание a b  Add(a, b,1,−1), 

VectorAdd(a, b,1,−1) 
a b  

Умножение на 

число 
сa  ScalarMultiply(a,c) 

VectorScalarMultiply(a,c) 
,с a с a   

Линейная 

комбинация 1 2с a с b  Add(a, b,с1,с2), 

VectorAdd(a, b,с1,с2) 
1* 2* , 1 2с a c b c a c b     

Скалярное  

умножение 
 ,a b  DotProduct(a,b) .a b  

Векторное  

умножение 
,a b 

   CrossProduct(a,b) &a b  
 

Продемонстрируем получение результатов операций из таблицы: 

>  

 

>  

 

>  
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>  

 

>  

 

>  

 

>  

 

Кавычки используются в левых частях равенств для подавления выпол-

нения операции и вывода лишь ее символьной записи.  

Норма вектора 

Норму вектора 1( ,..., )na x x , которая равна 

 
1/

1 ... , 1
n

n n
na x x n     , можно вычислить с помощью 

команды VectorNorm(a,n) (или Norm(a,n)): 

>  

 

>  

 

>  

 

>  

 

По умолчанию n = infiniti. При n = 2 (или n=Euclidean), как видно из при-

мера, получаем Евклидову норму, что для геометрических векторов означает их 

длину. Для нормирования вектора X можно применить функцию normalize(X,n), 

в результате которой будет получен орт 
0

X
X

X
  вектора X: 

>  
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Угол между двумя векторами 

Для вычисления угла между векторами используется значение его коси-

нуса при нахождении скалярного произведения. Достигается это с помощью 

команды VectorAngle(a, b, options): 

>  

 

>  

 

>  

 

>  

 

Нахождение базиса системы векторов 

Если имеется система 1 2{ , ,..., }na a a  n векторов, то с помощью команды 

Basis([a1,a2,…,an]) можно найти ее базис, а функция 

GramSchmidt([a1,a2,…,an]) ее ортогонализирует по алгоритму Грамма –

Шмидта. Если исходная система не является линейно независимой, то количе-

ство векторов в результате станет меньшим. Для выполнения нормализации 

необходимо ввести в аргументы команды параметр normalized: 

>  
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>  

 

>  

 
 

5.2. Матрицы и определители 

 

Способы задания матрицы 

Для определения матрицы в  Maple можно использовать 

команду Matrix(m, n, [[a11,a12,…,a1n], [a21,a22,…,a2n],…, [am1,am2,…,amn]]), где 

m  количество строк, n – количество столбцов в матрице. Эти числа задавать 

необязательно, а достаточно перечислить элементы матрицы построчно в квад-

ратных скобках через запятую: 

>  

 

С помощью дополнительных команд в Maple можно генерировать матри-

цы специального вида. В частности, диагональную матрицу и ее различные 

обобщения можно получить командой DiagonalMatrix(L,m,n,options), где L – 

список или вектор значений, m и n – размеры результирующей матрицы: 

>  

 

>  

 

>  
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>  

 

>  

 

Генерировать матрицу можно и с помощью функции y=f(i, j) от перемен-

ных i, j – индексов элементов матрицы Matrix(m, n, f): 

>  

 

>  

 

Размер матрицы А, количество ее строк и столбцов можно определить со-

ответственно с помощью команд Dimension(A), RowDimension(A) и ColumnDi-

mension(A). 
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Операции над матрицами (табл. 6)                                                   Таблица 6 

Перечень операций над матрицами 

Операция Математическая 

запись 
Maple-функция Краткая форма 

команды 

Сложение A+B 
Add(A, B), 

MatrixAdd(A, B) 
A+B 

Вычитание A−B 
Add(A, B,1,−1), 

MatrixAdd(A, B,1,−1) 
A−B 

Умножение на число сA  

ScalarMultiply(A,c), 

MatrixScalarMulti-

ply(A,c) 

,с A

с A




 

Линейная  

комбинация 
1 2с A с B  

Add(A, B,с1,с2), 

MatrixAdd(A, B,с1,с2) 

1* 2* ,

1 2

с A c B

c A c B



  
 

Умножение AB 

Multiply(A,B) 

MatrixMatrixMulti-

ply(A,B) 

.A B  

Возведение 

в степень 
nA  MatrixPower(A,n) A^n 

Обратная матрица 1A
 MatrixInverse(A) 

^ ( 1),

1 /

A

A


 

Транспонирование TA  Transpose(A) − 

 

В качестве второго аргумента в командах, вычисляющих произведение, 

можно указывать и вектор, например: 

>  

 

 

>  

 

>  
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>  

 

>  

 

>  

 

Определитель, минор, ранг и след матрицы 

Определитель квадратной матрицы А можно вычислить с помощью ко-

манды Determinant(A). Функция Minor(A,i,j) возвращает значение минора эле-

мента ija этой матрицы. С помощью специальных параметров последней ко-

манды можно не только вычислить миноры элементов квадратной матрицы, но 

и выделить различные подматрицы из исходной. 

Для определения ранга матрицы можно использовать команду Rank(A). 

След матрицы, равный сумме ее диагональных элементов, вычисляется коман-

дой Trace(A). 

Приведем примеры решения некоторых типичных задач с помощью спе-

циализированного пакета линейной алгебры: 

>  

 

>  

 

>  

 

Собственные значения и собственные векторы матрицы 

Получить характеристический многочлен матрицы А относительно пере-

менной x можно с помощью команды CharacteristicPolynomial(A, x). Для 
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нахождения собственных значений матрицы А используется команда 

Eigenvalues(A). Для нахождения собственных значений и собственных векторов 

матрицы А − команда Eigenvectors(A): 

>  

 

 

>  

 

>  

 

>  

 

>  

 

Канонические и специальные виды матрицы 

Выяснить, являются ли матрицы A и B подобными, можно с помощью 

команды IsSimilar(A,B). Ортогональность, унитарность, типы эрмитовых мат-

риц можно определить соответственно с помощью команд IsUnitary(A), 

IsOrthogonal(A) и IsDefinite(A,q=t), где t может принимать одно из следующих 

значений: 'positive_definite', 'positive_semidefinite', 'negative_definite', 'nega-

tive_semidefinite', or 'indefinite'. 

Привести матрицу А к нормальной форме Жордана можно с помощью 

команды JordanForm(A). Верхнюю треугольную матрицу, эквивалентную мат-
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рице А, вернет функция GaussianElimination(A). Характеристическую матрицу  

можно вычислить командой CharacteristicMatrix(A,x). Например: 

>  

 

>  

 

Кроме этого, из матриц можно конструировать другие с помощью опера-

ций удаления и добавления строк и столбцов (см. пакет LinearAlgebra). 

 

5.3. Системы линейных уравнений и матричные уравнения 

 

Система линейных уравнений A x b  может быть решена двумя способами.  

Способ 1. Стандартная команда solve находит решение системы линей-

ных уравнений, введенных в развернутом виде в числе аргументов:  

11 1 12 2 1 1

1 2 2

...

...............................................

...

n n

m m m mn n m

a x a x a x b

a x a x a x b

   


    

. 

Например, решим систему уравнений с тремя неизвестными: 

2 3 5 1,

4 6 2 2,

2 3 11 1.

x y z

x y z

x y z

  


  
   

 

Для этого введем систему, назначив ей имя slau, и используем в качестве 

аргумента команды solve: 

>  

 

>  
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Результат решения удобно также присвоить переменной. Например, для 

нахождения частного решения системы в этом случае можно использовать под-

становку: 

>  

 

Способ 2. Команда LinearSolve(A,b) из пакета LinearAlgebra находит ре-

шение уравнения A x b  введением аргументов А – матрица и b – вектор. 

Можно также ограничиться вводом одной расширенной матрицы системы, то 

есть матрицей, полученной приписыванием к матрице А системы столбца b 

свободных членов. 

Решение slau в этом случае будет выглядеть следующим образом: 

>  

 

Здесь _t02 – произвольная постоянная. В этом случае решение получено в 

виде вектора: 

>  

 

Если задать сразу расширенную матрицу системы, то результат может 

быть получен также с использованием команды LinearSolve: 

>  

 

Для решения систем линейных уравнений разными методами у команды 

LinearSolve есть целый арсенал дополнительных параметров, о которых можно 

узнать в справочной системе.  
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Ядро матрицы 

Ядро матрицы А – это множество векторов х, произведение матрицы А на 

которые равно нулевому вектору. Они представляют собой решение однород-

ной системы линейных уравнений с матрицей A. Найти ядро матрицы А можно 

командой NullSpace(A): 

>  

 

>  

 

 

5.4. Аналитическая геометрия 

 

Для решения задач евклидовой геометрии в Maple разработаны специали-

зированные пакеты: geometry и geom3d, назначение функций которых, в основ-

ном, соответствует их названию. Весь список команд можно увидеть, подклю-

чив пакеты с помощью команды with(). Напомним, что назначение любой ко-

манды при этом можно узнать, выделив ее в приведенном перечне и нажав 

<F2>. Рассмотрим применение некоторых из них. 

Задачи на плоскости (команды пакета geometry) 

Основными геометрическими объектами, с которыми работает Maple на 

плоскости, являются point (точка), segment (отрезок), dsegment (направленный 

отрезок), line (прямая), triangle (треугольник), square (квадрат), circle (окруж-

ность), ellipse (эллипс), hyperbola (гипербола), parabola (парабола), conic (кони-

ческое сечение, включая вырожденные случаи). Для их ввода в аргументах со-

ответствующей команды должны быть указаны имя и необходимые данные для 

их определения. Рассмотрим эти форматы: 

− point(A,xA,yA) – точка A с координатами xA и yA; 

− segment(AB,[A,B]) – отрезок AB; 

− dsegment(AB,[A,B]) – направленный отрезок AB; 
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− line(AB,[A,B]) – прямая AB; 

− triangle(ABC,[A,B,C]) – треугольник ABC; 

− square(ABCD,[A,B,C,D]) – прямоугольник ABCD; 

− circle(имя, параметры) – окружность; 

− ellipse(имя, параметры) – эллипс; 

− hyperbola(имя, параметры) – гипербола; 

− parabola(имя, параметры) – парабола; 

− conic(имя, параметры) – коническое сечение. 

Решим для примера некоторые задачи с треугольником. 

Определим и построим треугольник по его вершинам: 

>  

 

>  

 
Для вывода уравнения геометрического объекта нужно его задать, а затем 

вывести с помощью команды Eqution(name) или detail(name). При определении 

объекта Maple запросит имена осей, которым соответствуют переменные. По-

сле ввода ответа будет выведено уравнение. Например, найдем уравнение сто-

роны AC полученного треугольника. Определим прямую с помощью команды 

и введем запрос: 

>  

 

>  

На экране появится окошко с просьбой ввести имя горизонтальной оси: 
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Введем x, нажмем <enter>, далее появится аналогичное требование по за-

данию имени вертикальной оси. После ввода y, нажав <enter>, получим ответ: 

>  

 

Можем решить вопрос о принадлежности точки прямой, задав следую-

щую команду: 

>  

 

>  

 

Углы треугольника можно определить с помощью команды 

FindAngle(l1,l2), в которой аргументами являются прямые, ограничивающие 

треугольник. 

Найти медиану и ее точку пересечения со стороной можно по следующе-

му сценарию: 

>  
>  

assume that the names of the horizontal and vertical axes are _x 

and _y, respectively 

 

>  

>  

[0,3] 

Аналогично можно найти высоту и биссектрису с помощью определяю-

щих их команд altitude() и bisector() соответственно. С помощью команд пакета 

можно находить особые точки треугольника, длины ограничивающихся ими 

отрезков, периметр и площадь, параметры вписанной и описанной окружно-

стей, определять подобие и т. п.  
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Приведем пример преобразования плоской фигуры с определением ее но-

вых характеристик на примере поворота заданной параболы: 

>  
>  

>  

>  

 

>  

 
 

Задачи в пространстве (команды пакета geom3d) 

Для определения пространственных объектов существует гораздо больше 

конструкций по сравнению с плоскими. Некоторые (segment, dsegment, line, tri-

angle) задаются аналогично, другие имеют свои особенности или большее раз-

нообразие. Все подробности представлены в справочной системе. 

Для примера рассмотрим типичные задачи, которые решаются с пирами-

дой, заданной своими вершинами: 

>  
>  
>  
>  
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Построим уравнение плоскости основания ABC: 

>  
>  

Warning, assuming that the names of the axes are _x, _y and _z 

 

Вычислим площадь основания пирамиды и ее объем: 

>  

>  

 

>  

 

 

Упражнения 

 

1. Даны два вектора: (1,2,3,4), (2, 1,4,3)a b   . Найдите их нормы, ска-

лярное  и векторное произведения.  

2. Найдите смешанное произведение векторов 

(1,3, 1), (2,3,1), ( 1,2,4)a b c      и определите их ориентацию. 

3. Из системы векторов 
1 2 3 4(1,2,2, 1), (1,1, 5,3), (3,2,8,7), (0,1,7, 4)a a a a         

выделите базис и ортогонализируйте его.  
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4. Даны матрицы 
1 1 0 2 4 5

, ,
2 3 3 4 2 1

A B C
      

       
     

. Найдите их 

определители, обратные матрицы и произведение. 

5. Получите верхнюю треугольную матрицу, эквивалентную матрице  

1 2 1

10 12 2

3 4 5

A

 
 


 
  

. Найдите к ней обратную и 
3 2( ) 5 3P A A A A   . 

6. Найдите характеристический многочлен матрицы 

1 6 4

1 1 1

1 2 2

A

   
 

 
 
   

, ее 

собственные значения и собственные векторы. 

7. Решите систему уравнений 

2 6,

2 1,

3

x y z

x y

x y z

  


  
   

 с помощью формул Краме-

ра, обратной матрицы системы и методом Гаусса.  

8. Решите матричное уравнение АX = В, где 
1 2 3 5

,
3 4 5 9

A B
   

    
   

. 

9. Для матрицы 

1 1 0

0 2 1

1 3 1

A

 
 

 
 
  

 найдите ее ранг, дефект (d(A)=n–r(A), где 

n – размерность квадратной матрицы, r – ее ранг) и ядро. 

10. Для трех заданных на плоскости точек  A(1,2), B(5,7), C(7,−1) по-

стройте треугольник. Определите уравнения его сторон, медиан, высот, биссек-

трис. Найдите точки пересечения медиан. Определите радиусы вписанной и опи-

санной окружностей. Определите углы треугольника, его периметр и площадь. 

11. Постройте пирамиду по ее вершинам A(5,2,0), B(2,5,0), C(1,2,4), 

S(−1,1,1). Найдите уравнения граней и высоты, проведенной к основанию ABC. 

Определите угол между ребром AS и плоскостью основания в градусах. Вычис-

лите объем пирамиды и площадь одной из граней. 
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6. Элементы дискретной математики 

6.1. Комбинаторика 

 

Для решения задач с конечными множествами и их конфигурациями в Maple 

имеется ряд встроенных функций и несколько специализированных пакетов.  

Способы задания конечного множества 

Для задания в Maple конечного математического множества с помощью 

перечисления его элементов можно использовать объект типа set (набор). Это 

неупорядоченная последовательность выражений в фигурных скобках, в кото-

рой нет повторяющихся элементов. При обработке данных этого типа Maple 

оставляет каждый элемент в одном экземпляре и упорядочивает их: 

>  

 

Для определения мощности множества М можно использовать функцию 

nops(M): 

>  

 

Значение любого элемента множества можно получить с помощью его 

индекса согласно порядку, установленному Maple. Для индексации используют 

натуральные значения (первому элементу соответствует 1) и им противополож-

ные (последнему элементу соответствует(−1)): 

>  

 

 

 

 

Для выбора из множества нескольких элементов можно использовать 

объект «диапазон», причем положительные значения индекса соответствуют 

отсчету элементов слева направо, а отрицательные – справа налево: 

>  
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Если необходимо задать упорядоченное множество с повторяющимися 

элементами, то можно выбрать объект типа list (список). В этом случае элемен-

ты сохраняют тот порядок, в котором были введены пользователем. Каждый 

элемент можно получить с помощью индекса аналогично описанной выше про-

цедуре: 

>  

 

>  

 

 

 

Важно заметить, что индексной форме элемента множества, заданного в 

форме list, можно присвоить новое значение, а в форме set – нельзя: 

>  

 

 

>  

Error, cannot reassign the entries in a set 

 

Множество можно задать также с помощью характеристического свой-

ства, используя команду seq(): 

>  

 

>  

 

Еще одним удобным инструментом для определения множества служит 

операция повторения $: 

>  

 

>  
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>  

 

>  

 

 

В этом случае последовательность выражений сохраняет полученный по-

рядок, и каждый ее элемент имеет индексную форму. 

Операции над множествами (табл. 7)                                             Таблица 7 

Перечень операций над множествами 

Операция 
Математическая 

запись 
Maple-функция 

Краткая форма 

команды 

Объединение A B  A union B A B  

Пересечение A B  A intersection B A B  

Вычитание \A B  A minus B \A B  

Дополнение A  E minus A \E A 

Симметрическая 

разность 
A B  (A minus B) union (B minus A) ( \ ) ( \ )A B B A  

Подмножество A B  A subset B A B  

 

Введенные операции можно проводить только для объектов типа set. 

Поэтому для их применения, если тип данных не соответствует, можно вос-

пользоваться командой преобразования convert. Например, для множества L, 

заданного с помощью объекта list, это просто: 

>  

 

А в случае задания с помощью последовательности выражений − необхо-

димо сначала перевести, например, в табличный тип, используя оператор цик-

ла, а затем конвертировать: 

>  
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Вывод всех элементов можно подавить с помощью фиксатора конца ко-

манды (:). Сравните в этом случае результат работы команды: 

>  

 

Рассмотрим результат работы команд на примере трех множеств: 

>  

 

>  

 

>  

 

>  

 

>  

 

В пакете combinat содержатся функции для работы с простейшими ком-

бинаторными конфигурациями. Пакет combstruct используется для определения 

более сложных комбинаторных структур. Рассмотрим полезные функции паке-

та combinat. Для его подключения нужно воспользоваться командой 

with(combinat). 

Декартово произведение 

Для определения декартова произведения 1 2 ... nM M M    n множеств, 

заданных как тип set или list, может быть использована функция cartprod(ll), 

где ll – перечисление заданных множеств в виде списка в квадратных скобках. 

Эта функция возвращает два значения: finished − логическое значение, позво-

ляющее определить последний элемент сгенерированного множества, и next-

value – итерационная процедура для его получения: 
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>  

. 

Для того чтобы вывести полученные элементы можно создать простой 

цикл, использующий эти значения: 

>  

>  

 

 

 

 

 

 

С помощью функции powerset(n) можно сгенерировать множество всех под-

множеств совокупности первых n натуральных чисел (булеан множества {1,2,... }n : 

>  

 

>  

 

Функция subsets аналогично cartprod позволяет создать итерационный про-

цесс для генерирования булеана конечного множества M c помощью процедуры 

>  

 

 

 

 

 

 

 

 

При решении комбинаторных задач полезным инструментом является 

биекция между множеством натуральных чисел с нулем и множеством векто-

ров фиксированной длины с целыми неотрицательными компонентами или со 
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множеством одночленов. На примере трехразрядных векторов эти соответствия 

может продемонстрировать табл. 8. 

Таблица 8 

Пример биекций 
Число Вектор Одночлен 

0 [0,0,0] 1 

1 [1,0,0] x  

2 [0,1,0] y 

3 [0,0,1] z  
4 [2,0,0] 2x  

5 [1,1,0] xy  

6 [1,0,1] xz  

7 [0,2,0] 2y  
 

В пакете combinat есть функция inttovec(i,n), которая возвращает i-й вектор 

длины n. С помощью простого цикла можно сгенерировать конечное число таких 

векторов: 

>  

 

 

 

 

 

 

 

 

 

 

 

Вторая функция vectoint(L) по заданному вектору возвращает соответ-

ствующее ему натуральное число. Например: 

>  

 

Перестановки 

Функция permute(n) при натуральном значении n генерирует все переста-

новки множества {1,2,…,n} и представляет результат как список списков. Это 
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позволяет, присвоив полученному множеству имя, получить доступ к его лю-

бому элементу, то есть к любой перестановке. Число nP полученных перестано-

вок можно определить, найдя мощность полученного множества: 

>  

 

>  

 

>  

 

Для нахождения числа перестановок произвольного множества из n эле-

ментов без повторений ( !nP n ) можно воспользоваться функцией 

numbperm(n): 

>  

 

Если в качестве аргумента функции permute задать конкретное множе-

ство, то она сгенерирует все его перестановки. Сравните результаты работы при 

вводе множества с помощью различных типов данных: 

>  

 

>  

 

>  

 

>  

 

Для нахождения числа перестановок, когда каждый элемент входит за-

данное число раз, можно воспользоваться известной комбинаторной формулой 

1
1

1

( ... )!
( ,..., )

! ... !

m
n m

m

n n
P n n

n n

 


 
, которая вычисляется функцией multinomi-

al 1( , ,... )mn n n , или сгенерировать это множество, а затем определить его мощ-

ность. Сравните: 

>  

>  
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>  

 

 

Функция randperm(M) генерирует случайную перестановку множества M, 

которое задано в виде set или list, а если аргумент представлен натуральным 

числом, − множества первых n натуральных чисел: 

>  

 

>  

 

Размещения 

Функция permute(n,m) при натуральных значениях n и m генерирует все 

размещения множества {1,2,…,n} по m элементов без повторения и представляет 

результат как список списков. Это позволяет, присвоив полученному множеству 

имя, получить доступ к его любому элементу, то есть к любому размещению. 

Число m
nA  полученных размещений можно определить, найдя мощность получен-

ного множества или воспользовавшись функцией numberm(n,m): 

>  

 

>  

 

>  

 

Если в качестве первого аргумента функции permute указать конкретное 

множество в виде set или list, то в первом случае будут сгенерированы все раз-

мещения без повторения элементов, а во втором – с тем количеством повторе-

ний, которые будут заданы в списке: 

>  

 

>  

 

>  

 

>  
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>  

 

Сочетания 

Функция choose(n,m) при натуральных значениях n и m генерирует все 

сочетания множества {1,2,…,n} по m элементов без повторения и представляет 

результат как список списков: 

>  

 

Это позволяет, присвоив полученному множеству имя, получить доступ к 

его любому элементу, то есть к любому сочетанию. 

Число m
nC  полученных сочетаний можно определить, найдя мощность 

полученного множества или воспользовавшись функцией numbcomb(n,m): 

>  

 

>  

 

Если в качестве первого аргумента функции choose указать конкретное мно-

жество в виде set или list, то в первом случае будут сгенерированы все сочетания без 

повторения элементов, а во втором – с тем количеством повторений, которые будут 

заданы в списке: 

>  

 

>  

 

>  

 

>  

 

Сравните последнее значение с результатом, полученным по формуле 

1

m m
n n mC C   . 

Функция randcomb(M,m) генерирует случайное сочетание из элементов 

множества M по m, которое задано в виде set или list, а если аргумент представ-
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лен двумя натуральными числами, − случайное сочетание из множества первых 

m натуральных чисел по m: 

>  

 

>  

Рекуррентные соотношения и производящие функции 

Для нахождения общего и частного решений рекуррентного соотноше-

ния, а также его производящей функции можно использовать функцию rsolve c 

соответствующими аргументами и параметрами. Рассмотрим различные случаи 

на примере рекуррентного соотношения ( ) 5 ( 1) 6 ( 2)f n f n f n    . Записав в 

качестве первого аргумента функции заданное соотношение, а в качестве вто-

рого – переменную для обозначения общего члена искомой последовательности 

(например, , ( ), ( )f f n f k ), получим выражение, в котором произвольные посто-

янные будут выражены через нулевой и первый члены: 

>  

 

 

Если первый аргумент представляет собой множество, содержащее, кро-

ме самого равенства, начальные условия, то будет получено частное решение: 

>  

 

Наконец, для нахождения производящей функции для заданной последо-

вательности необходимо добавить специальный параметр: 

>  

 

Для работы с производящими функциями можно использовать также 

специализированный пакет genfunc, который содержит несколько функций для 

работы с производящими функциями: 

>  
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Например, команда rgf_sequence позволяет построить по заданной произ-

водящей функции соответствующую рекуррентную последовательность и 

определить начальные значения и порядок, а также сгенерировать ее элементы: 

>  

>  

 

>  

 

> 

 

 

>  

 

 

 

 

 

 

 

 

 

 

 

Разбиения и композиции чисел 

Получить все разбиения натурального числа n на неубывающие последо-

вательности натуральных чисел, суммы которых равны n при условии, что по-

рядок учитывается, можно с помощью функции combinat пакета partition(n): 

>  

 

>  

 

Таким образом, число 5 можно представить в виде семи сумм натураль-

ных чисел с точностью до порядка слагаемых. 
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Если необходимо сгенерировать разбиения с максимальным значением m 

слагаемых, то используется команда с дополнительным параметром m: 

>  

 

Для каждого из разбиений p можно определить сопряженное с помощью 

функции conjpart(p). Найдем сопряженное к разбиению 5 = 2 + 3 и для нагляд-

ности построим диаграмму Феррерса для них: 

>  

 

>

 

 
 

Напомним, что транспозиция диаграммы Феррерса определяет биектив-

ное соответствие между разбиениями числа n на k слагаемых и разбиениями 

числа n с наибольшим слагаемым, равным k. 

Функция numbpart(n) определяет число разбиений числа n. С ее помощью 

построим производящую функцию для такой последовательности значений и 

проверим справедливость пентагональной теоремы Эйлера: 

>  

 

>  

 

>  
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Аналогичные задачи можно решать и по композициям натуральных чисел 

с дополнительным требованием – учетом порядка следования слагаемых. Для 

этих целей в пакете combinat предусмотрены функции composition, numbcomp и 

некоторые другие (см. в справочной системе). 

Последовательности специальных чисел 

Кроме перечисленных выше задач в пакете combinat можно генерировать 

последовательности специально определенных чисел. Это биномиальные ко-

эффициенты, числа Фибоначчи, Стирлинга, Каталана, Белла и др.  

 

6.2. Алгебра логики 

 

В Maple имеется пакет Logic, в котором можно, используя двоичную ло-

гику, совершать некоторые действия над булевыми функциями. В частности, 

получать для заданной в виде аналитического выражения булевой функции ее 

канонические формы, минимальную ДНФ, представлять в виде полиномов Же-

галкина и т. п. В отличие от логических переменных Maple, которые поддержи-

вают трехзначную логику, в этом пакете можно работать только с булевыми 

значениями. Отличие операций связано с наличием нейтрального оператора &, 

приписанного в виде префикса ко всем именам логических операторов. Напри-

мер, &or, &ob, &not и т. д. Например,  

>  

>  

 

Среди функций Maple также можно найти работающие с таблицами ис-

тинности. Рассмотрим на примере построения простых процедур возможность 

получить таблицу истинности в привычном формате. Для этого определим че-

рез процедуры-функции, не привлекая специализированные пакеты, логические 

функции, а затем по таблице истинности построим совершенную дизъюнктив-

ную нормальную форму: 
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>  
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>  

 

 

 

Последнее выражение соответствует СДНФ xyz xyz xyz xyz   . 

 

6.3. Графы 

 

В Maple имеется два пакета, помогающих решить задачи на графах: это 

пакет networks ранних версий системы и GraphTheory – более поздних. Рас-

смотрим некоторые из функций (их количество превышает 150) второго пакета, 

которые доступны лишь после его подключения. Одна часть из них использует-

ся для описания и изображения графов, другая – для операций с заданными 

графами, проверки их свойств, третья – для решения задач на графах. Суще-
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ствует ограничение: Maple работает с простыми графами (без петель и кратных 

ребер). 

Рассмотрим несколько примеров задания графов и решения на них задач 

с помощью процедур пакета.  

Способы задания графов 

Для задания графа как объекта Maple используется команда Graph() c по-

тенциально большим перечнем аргументов. Они зависят, главным образом, от 

способа задания графа и его типа (см. справочную систему). В основном, это 

следующие действия: задать пустой граф с его порядком, а затем добавить реб-

ра (дуги); перечислить определенным способом его вершины и ребра; ввести 

матрицу смежности или весовую и т. п. Рассмотрим примеры разных способов 

задания графов и их изображения. 

>  
>  

 

>  

 

>  

 

>  

 

>  

 

>  

 

>  

 
>  

>  
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>  

 
 

Задачи на графах 

1. Задача о максимальном потоке. 

>  
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2. Задача о нахождении кратчайших путей. 

>  
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3. Задача коммивояжера. 

>  

 

 
 

 

4. Задача о хроматическом числе и полиноме. 

>  

 

 
 

 

 

 

 

 

5. Задача о минимальном остовном дереве (граф из задачи 2). 

>  
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Можно также решить эту задачу с помощью других алгоритмов и в ани-

мированной форме, наблюдая за процессом построения. Покажем лишь по-

следний кадр. 

 

 

 

 

 

Сравните полученные результаты. 
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6.4. Элементы теории чисел 

 

В Maple для решения некоторых задач теории чисел существует специа-

лизированный пакет процедур: 

>  

 

Мы рассмотрим лишь некоторые операции по определению объектов в 

Maple, с которыми оперирует классическая теория чисел. 

Приведем примеры некоторых целочисленных функций:  

1) factorial(n) – факториал числа n; 

2) iquo(a,b) – частное от деления числа a на число b; 

3) irem(a,b) – остаток от деления числа a на число b; 

4) igcd(a, b) − наибольший общий делитель чисел a и b; 

5) lcm(a,b) − наименьшее общее кратное чисел a и b; 

В исполнении Maple это будет выглядеть следующим образом: 

>  

 

>  

 

>  

 

Кроме этого, при вводе целого числа можно вызвать контекстное меню, в 

котором есть раскрывающаяся вкладка Number Theory Functions (Функции тео-

рии чисел): Би
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Приводим некоторые результаты, полученные таким способом, для числа 50: 

> numtheory:-divisors(50);# список делителей числа 50 

 

> numtheory:-sigma(50);# сумма делителей числа 50 

 

> numtheory:-tau(50);#количество делителей числа 50 

 

> numtheory:-pi(50);# количество простых чисел, не превосходящих 

50 

 

Оператор композиции @@ может использоваться для создания сложных 

функций, содержащих цепные дроби: 

>  

 

>  

 

В заключение заметим, что в Maple реализован большой список функций 

для работы в конечных кольцах и полях. 
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Упражнения 

 

1. На универсальном множестве десятичных цифр выполните следующие 

операции над множествами {0,1,2,3,4,5}, {4,5,6,7}A B  : 

, , \ , \ , ,A B A B A B B A A A B . 

2. Даны множества: делителей числа 1235, корней уравнения 

3 233 279 247 0x x x     и нечетных чисел от 1 до 65 включительно. Найдите 

множества , ,( ) ,A B B C A B C A B C . 

3. Даны множества { , , , }, {1,2,3}A a b c d B  . Выведите элементы прямого 

произведения A B  этих множеств. Определите мощности множеств и число их 

подмножеств. 

4. На множестве {1,2,3,4,5}A  задано бинарное отношение 

2{( , ) : 7}R x y A x y    . Составьте его матрицу. Изобразите на координатной 

плоскости элементы этого отношения и соответствующий ему граф. 

5. Найдите последовательность, заданную рекуррентным соотношением 

( 2) 7 ( 1) 6 ( ) (2 1)3nf n f n f n n       и начальными условиями 

(0) 0, (1) 1f f  . Постройте для найденной последовательности производящую 

функцию. Упростите, если необходимо, полученное выражение. 

6. Найдите коэффициент при 
5 9x y  в разложении 

14(2 3 )x y . 

7. Для булевой функции ( , , ) |f x y z xy z z y x     постройте таблицу 

истинности, запишите ее характеристическое множество, постройте СДНФ и 

упростите, если необходимо. 

8. Функции заданы своими характеристическими множествами: 

1 1

0 0 0 0 0 0

0 0 1 0 1 0
,

1 0 0 1 1 0

1 1 1 1 1 1

f gM M

   
   
    
   
   
   

. 

Найдите характеристические множества и ДНФ функций 

, , , , , ,f g f g fg f g f g f g    . 
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9. Изобразите неориентированный граф со множеством { , , , , , }V a b c d e g  

вершин и множеством  { , },{ , },{ , },{ , },{ , },{ , },{ , },{ , }E a b a c a d a g b c b d c d d e  

ребер. Составьте его матрицы смежности и инцидентности. Определите степе-

ни вершин. Выясните, является ли он планарным. Найдите хроматическое чис-

ло и полином. 

10. Изобразите орграф со множеством { , , , }V a b c d  вершин и множе-

ством  ( , ), ( , ), ( , ),( , ), ( , ), ( , )E a b b c b d c d d a d b  дуг. Составьте его матрицы 

смежности и инцидентности. 

11. Определите связный неориентированный простой граф седьмого по-

рядка  с десятью ребрами. Выведите его изображение. Найдите матрицы смеж-

ности, инцидентности, радиус, диаметр и центр. Постройте реберный (сопря-

женный) граф. 

12. Припишите ребрам графа из задачи 9 вес (положительное число). Для 

полученного взвешенного графа постройте минимальное остовное дерево раз-

ными методами. 

13. Определите, изоморфны ли графы. 

             

14. Найдите: 

1) всевозможные комбинации чисел от 1 до 6; 

2) всевозможные комбинации по 3 числа из чисел от 1 до 5; 

3) представление числа 10 в виде суммы натуральных слагаемых; 

4) представление числа 10 в виде суммы трех натуральных слагаемых; 

5) число Фибоначчи с номером 100; 

6) количество простых делителей числа 100; 

7) положительные делители числа 100; 

X

X4 

X7 

X5 

X6 X

X1 

Y

Y4 

Y7 

Y5 

Y6 Y

Y1 
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8) простые делители числа 100; 

9) разложение числа 10 560 на простые множители; 

10) 100-е простое число; 

11) наименьшее общее кратное чисел 11, 15, 9; 

12) наибольший общий делитель чисел 550, 220, 60; 

13) остаток от деления 4328 на 22; 

14) число сочетаний 26
100C ; 

15) число размещений 4
11A . 
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